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1 – Safety Precautions and Technical Specifications

AC Power

WARNING: All electrical equipment must meet applicable codes and be 
installed by NORAN Instruments authorized support 
representatives.

WARNING: Dangerous voltages are present inside the equipment.
High operating voltages are present inside the equipment. These voltages can produce 
severe burns or fatal electrical shocks.

• Failures in improperly grounded equipment can transfer dangerous voltages to 
outside surfaces.

• Numerous internal components operate at high voltages and may not be 
insulated or shielded.

• Components such as capacitors and batteries can store high voltages even with 
the power disconnected.

WARNING: Maintain proper equipment grounding.
• Always connect equipment to a properly grounded power source receptacle. If 

in doubt, have the receptacle checked by a qualified technician.

• Never use a ground adapter plug to connect NORAN Instruments’ equipment to 
a power source receptacle that lacks ground connection terminals.

• Never operate your NORAN Instruments’ equipment if you notice unusual 
noises or foul odors. Disconnect the power cord from the main power source 
and call your local NORAN Instruments support specialist.

WARNING: Avoid contact with internal high voltage sources.
• Never remove any outer covers or guards that are fastened with screws without 

being so instructed either by this manual, or by a qualified NORAN Instruments 
support specialist.

• Never attempt internal service or system adjustments unless instructed to do so 
either by this manual, or by a qualified NORAN Instruments support specialist.

• Never remove system connections when power is applied.
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• Never override or “cheat” electrical or mechanical interlock devices.

• When working around high voltage sources, be sure all power inputs are 
disconnected.

• When working around capacitors, batteries, and other power sources, allow a 
few minutes for capacitors to discharge after power has been removed.

• Avoid contact, direct or through metal tools or jewelry, with any uninsulated, 
internal, electrical component without being so instructed either by this manual, 
or by a qualified NORAN Instruments support specialist.

CAUTION: The fuse in the power entry module must match the line voltage.

P-10 Gas
The flow proportional counter requires a special gas called P-10. Tanks of P-10 gas are 
available from local bottled gas suppliers. The tank of P-10 should have a two-stage 
regulator with a 1/4 NPT fitting to accept the NORAN-supplied third stage regulator.

WARNING: P-10 gas is a HAZARDOUS MATERIAL. Handle P-10 gas in 
accordance with the manufacturer’s Material Safety Data Sheet.

WARNING: Fasten the tank of P-10 gas securely to a fixed object, such as a 
wall or workbench, to avoid damage to the tank. The tank contains 
hazardous material under pressure. The tank is dangerous if its 
valve is damaged or the tank is punctured. However, the gas is not 
flammable.

Diffractors

CAUTION: Do not touch the face of the diffractors.

CAUTION: Do not touch or attempt to clean the surface of any diffracting crystal.
The diffractor surfaces are sensitive and some can be dissolved with cleaning solvents, 
including water.

Manual Gate Valve Option
Never pump the column down with the gate valve closed and the spectrometer at 
atmosphere.

WARNING: Do not open the gate valve when the SEM is at vacuum and the WD 
spectrometer is at air.

Opening the gate valve under these conditions could expose the microscope vacuum 
system to contamination. If the filament is powered on, it may also be damaged.
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WD Spectrometer Controller

WARNING: All electrical equipment must meet applicable codes and must be 
installed by NORAN Instruments authorized support 
representatives.

WARNING: Dangerous voltages are present inside the equipment.
High operating voltages are present inside the equipment. These voltages can produce 
burns or fatal electrical shocks. Numerous internal components operate at high voltages 
and may not be insulated or shielded. 

Components such as capacitors can store high voltages even with the power 
disconnected. When you are working around high voltage sources, be sure all power 
inputs are disconnected.

Never remove any outer covers or guards that are fastened with screws without being 
instructed by this manual or by a qualified NORAN Instruments support specialist.

Never attempt internal service or system adjustments unless instructed to do so either 
by this manual or by a qualified NORAN Instruments support specialist.

Maintain proper equipment grounding.

Always connect equipment to a properly grounded power source receptacle. If in doubt, 
have the receptacle checked by a qualified technician.

Never use a ground adapter plug to connect NORAN Instruments equipment to a power 
source receptacle that lacks ground connection terminals.

CAUTION: Do not move the stage when the MAXray optic is inserted without 
knowing its position. Driving the stage into the optic will damage the 
optic.

CAUTION: The controller must be installed according to the procedures described 
in the installation and service manual to avoid damage to the 
spectrometer.

CAUTION: The fuse(s) in the controller must match the line voltage.

CAUTION: Check that the fuse(s) for the input AC voltage are correct. 
The switching power supply has a universal input autoranger that eliminates the 
requirement of changing jumper wires or switches to change the input voltage range, but 
the correct fuse(s) must be installed.

• For 100/120 VAC operation use one T 250V 3A fuse.

• For 230/240 VAC operation use two T 250V 2A fuses (5x20 mm).
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CAUTION: For continued protection against fire, replace the fuse(s) only with the 
specified type.

CAUTION: Do not place objects under or around the bottom of the controller that 
would restrict the cabinet cooling.

Never operate your NORAN Instruments equipment if you notice unusual noises or foul 
odors. Disconnect the power cord from the main power source and call your local 
NORAN Instruments support specialist.

CAUTION: Make sure the P-10 gas flow through the proportional counter is correct 
before energizing the detector.

Flow Proportional Counter Window

CAUTION: The material that isolates the gas inside the detector from the vacuum 
of the spectrometer and the SEM chambers is made of polypropylene. 
If the window must be replaced, follow these precautions:

CAUTION: Shut off the high voltage to the detector.

CAUTION: Turn off the P-10 gas.

CAUTION: Solvents must not come into contact with the window.

WARNING: Do not seal off the gas flow routinely or the window will break. 

Motorized Retraction and Manual Retraction
Do not change the retraction limits set during installation.

Detector Touch Sensor Module
The Detector Touch Sensor module requires a nine volt battery and contains a buzzer, 
LED, and control circuitry. The input from the touch sensor is via a coax connector as is 
the output to the stage automation system. The control circuitry consumers 
approximately 25 microamperes during normal operation and approximately three 
milliamperes when touch occurs.

• The contract closure from the Touch Sensor on the detector is connected to the 
input of a discriminator and terminated with a one megohm resistor to the 
battery and a 0.1 microfarad capacitor to ground. When a touch condition 
occurs this signal is grounded.

• The output to the stage automation system is from an open drain terminated 
with a one megohm resistor to the battery and a 5.1 volt zener diode to ground. 
This signal should be connected to a TTL input with a pull-up resistor in the 
stage automation system. The signal is a negative true signal (touch = ground 
and no touch = +5 volts) and is capable of sinking up to five milliamperes.
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• When a touch occurs the LED is turned on and the buzzer sounded.

• When the battery voltage decreases to approximately seven volts the LED and 
the buzzer are turned on momentarily about once every five seconds to indicate 
the battery should be replaced.

NOTE: If replacement of any part is required on the printed circuit board removal 
of all flux is required. The control integrated circuit and associated compo-
nents are all high impedances and any residue flux can adversely affect 
the circuit operation.

NOTE: If trouble shooting the board is required insert 90 megohms of resistance 
in series with a oscilloscope 10 megohm probe. This way the probe will not 
load the circuit and adversely affect your trouble shooting.

NOTE: If the Detector Touch Sensor Module is being used without being con-
nected to the stage automation system connect the ground wire provided 
between a chassis ground and the Stage BNC of the module. This will pre-
vent the sensor from floating and building up a charge which could distort 
the SEM image.

Interface Signal Description

Sensor BNC
The contact closure form the detector is connected to the module input BNC through a 
coax cable. The signal is terminated with a one megohm resistor to the battery and a 0.1 
microfarad capacitor to ground. When a touch condition occurs this signal is grounded.

Stage BNC
The output to the stage automation system is from an open drain terminated with a one 
megohm resistor to the battery and a 5.1 volt zener diode to ground. This signal should 
be connected via a coax cable to a TTL input with a pull-up resistor in the stage 
automation system. This signal is a negative true signal (touch = ground and no touch = 
+5 volts) and is capable of sinking up to five milliamperes.

NOTE: If the Detector Touch Sensor Module is being used without being con-
nected to the stage automation system connect the ground wire provided 
between the sensor from floating and building up a charge which could dis-
tort the SEM image.
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Touch Sensor Module Checkout Procedure

Equipment
• VOM

• Test resistor divider network and clip leads

• Phillips screwdriver (small)

NOTE: If replacement of any part is required on the printed circuit board removal 
of ALL flux is required. The control integrated circuit and associated com-
ponents are all high impedances and any residue flux can adversely affect 
the circuit operation.

NOTE: If trouble shooting the board is required a nine volt battery and contains a 
buzzer, LED, and control circuitry. The input from the touch sensor is via a 
coax connector. The output to the stage automation system is also from a 
coax connector. The control circuitry consumes approximately 25 micro-
amperes during normal operation and approximately three milliamperes 
when touch occurs.

1. Remove the module cover by removing the four small Phillips screws.

2. Install the 9 volt battery if necessary.

3. Measure the voltage across the battery to insure a charged battery.

4. Measure the voltage at the output Stage BNC. The voltage should be between 4 and 5 volts.

5. Use a clip lead and short the input Sensor BNC. The LED should turn on, the Buzzer should 
sound, and the voltage at the output Stage BNC should go to approximately 0 volts.

6. Remove the battery from the module. Use the following resistor divider network to rest the low 
battery voltage condition.

7. Measure the voltage going into the printed circuit board battery connector J3. It should be 
approximately 6 volts. The module LED should flash and the alarm buzz approximately once 
every five seconds.

8. Remove the resistor divider, clip leads, etc.. Replace the cover.

2K49

4K99

9 VOLT 
BATTERY



1 –  Safety Precautions and Technical Specifications Detector Touch Sensor Module

MAXray Service and Installation Manual 1-7

List of Materials Report for Touch Sensor Board Assembly

Item Quantity Part Number Value Ref Description

1 1 150A103385 .1MF C1

2 1 170A141753 PWB

3 3 150A112766 .01MF C3, C4, C5

4 1 480A000808 1N4150 CR1

5 1 245A002369 RED DS1

6 2 210A003313 BNC J1, J2

7 1 210A128705 CON2 J3

8 1 470A000113 1K R1

9 1 470A000175 910K R2

10 1 470A000138 150K R3

11 2 470A000153 4M7 R4, R9

12 1 470A000115 1K5 R5

13 1 470A000159 470K R6

14 3 470A000145 1M R7, R8, R14

15 2 470A000152 3M R10, R11

16 1 470A000148 1M5 R12

17 1 470A000120 3K9 R13

18 1 130A111669 BUZZER SPK1

19 1 210A117653 BLACK_TP TP1

20 1 318A128706 8213 U1

21 1 480A000811 1N5231 VR1

22 1 140G127866 Touch Sensor Front Panel

23 1 254A110049 LED Grommet

24 1 400A130215 Battery 9 Volt

25 4 280a108596 Screw 2-56 0.281 Pan

26 2 280a001094 Nut 4-40 Elastic Stop

27 2 280a116753 Nut Hex 7/16 - 26

28 2 280a002372 Screw 4-40 0.25 SS Pan Head Blk Ox

29 1 930a130218 Touch Sensor General Description

30 0 930a130216 Assembly Instructions

31 0 930A135936 Touch Sensor Module Checkout Procedure
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Schematic
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Assembly Drawing (top)

BT1

SPK1

CR1

R5
R4
R3
R2

C1
C2

R1 C3
U1 R7

J1

C5
C4

R13
R12
R11

R9
R10

R8

DS1

J2TP1

VR1

R14

R6
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Box Drawing

Detector Touch Sensor

Detector Touch Sensor

5

4

3

1

2

6

00 0 REF 700P127869 A TOUCH SENSOR ALARM BOX

01 2 2 280A122449 B SCREW, 4-40 X 1/4 PAN HD PHIL SS

02 1 NO 176A141753 A TOUCH SENSEE BOARD ASSEMBLY

03 1 NO 145A112823 B PLASTIC ENCLOSURE

04 1 NO 140G127867 M TOUCH SENSOR REAT PANEL

05 2 2 610P003216 M CABLE BNC TO BNC PLUG 6'

06 1 NO 910P130218 A CABLE BNC TO PLUG 6'

(4) self-adhesive feet
(provided w/box)
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SEM Venting and Window Protection
Always loosen an unused port cover before venting the SEM. Air or nitrogen entering the 
chamber can easily break the proportional counter window.

Symbols
the following symbols are used on this equipment:

Electrical Specifications
WD spectrometer controller input power requirements

100 to 240 volts ACL 50/60 Hz, 2.5 amperes maximum Voltage: 100/120/230/240 VAC

Frequency: 50/60 Hz

Fuses: 100/120 VAC - T 250V 3A

230/240 VAX - T 250V 2A

Internal on Switching power supply - 250V 4A

Symbol Description

CAUTION. Refer to accompanying documents.

CAUTION. Risk of electric shock.

Protective Conductor Terminal

Frame or Chassis Terminal

On (supply)

Off (supply)

!
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WD Spectrometer Controller Input/Output Connectors

Mapping (BNC)

VAC-OK (BNC)

PCS (9-pin D Female)

Signal Description

Map Out Output: TTL level: (0 to 3.5 V: 24 mA)

Signal Description

VAC-OK Input: TTL level (0 to 3.5 V: 10 mA)

Pin number Signal Description

1 HVSET Output: Analog level: 0 to 12V @ 6 mA

2 LLD Output: Analog level: 0 to 12V @ 6 mA

3 HVINT Output: TTL level (0 to 3.5 V: 24 mA)

4 -15V Output: -15V @ 400 mA maximum

5 SCAL Input: TTL level (0 to 3.5 V: 24 mA)

6 ULD Output: Analog level: 0 to 12V @ 6 mA

7 Ground

8 Ground

9 +15V Output: +15V @ 400 mA maximum

5 4 3 2 1

6 7 8 9
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Serial (9-pin D Male)

Motor (15-pin D Female, High-Density) 

Pin number Signal Description

1 DCD Carrier Detect. Not used.

2 RXD Input: to RS-232 transceiver - 
(maximum input voltage ±30 V: 10 mA)

3 TXD Output: from RS-232 transceiver
(output rating: VOL = 0.4V @ 3.2 mA and 
VOH = 3.5V @ -1.0mA)

4 DTR Data Terminal Ready. Not used.

5 Ground

6 DSR Data Set Ready. Not used.

7 RTS Request to Send. Not used.

8 CTS Clear to Send. Not used.

9 RI Ring Indicate. Not used.

Pin number Signal Description

1 5 volts Output: Encoder power

2 ENC_B Input: digital TTL level (0 to 3.5 V: 10 mA) 
Encoder Channel B output

3 ENC_A Input: digital TTL level (0 to 3.5 V: 10 mA) 
Encoder Channel A output

4 EMC_INDEX Input: digital TTL level (0 to 3.5 V: 10 mA) 
Encoder Index output

5 HOME Input: digital TTL level (0 to 3.5 V: 10 mA) 
Encoder Home output

6 LIM_1 Input: digital TTL level (0 to 3.5 V: 10 mA) Limit 
#1 sense output

7 LIM_2 Input: digital TTL level (0 to 3.5 V: 10 mA) Limit 
#2 sense output

8 N/C No connection

1 2 3 4 5

6 7 8 9

5 4 3 2 1

15 14 13 12 11

10
9 8 7

6
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Keyboard (5-pin DIN)

9 Ground

10  MOTOR_C Output: Analog level (0 - 24 V: 1.5 A max) Motor 
winding C.

11 MOTOR_D Output: Analog level (0 - 24 V: 1.5 A max) Motor 
winding D.

12 N/C

13 MOTOR_A Output: Analog level (0 - 24 V: 1.5 A max) Motor 
winding A.

14 MOTOR_B Output: Analog level (0 - 24 V: 1.5 A max) Motor 
winding B.

15 N/C

Pin number Signal

 1 Keyboard Clock Output: VOL = .45V @ 10 mA and VOH = 2.4V @ 
-2.6 mA

2 Keyboard Data Input: VOL = .45V @ 10 mA and VOH = 2.4V @ -
2.6 mA

3 Not connected

4 Ground

5 +5V. Output: Keyboard power

Pin number Signal Description

13

2
5 4
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Display (15-pin D Female, High Density) 

PCS Assembly Input Power Requirements
+15V @ 400 mA maximum

-15V @ 400 mA maximum

Pin number Signal

1 Red Output: analog level (0 - 2V @ 25 mA)

2 Green Output: analog level (0 - 2V @ 25 mA)

3 Blue Output: analog level (0 - 2V @ 25 mA)

4 N/C

5 Ground

6 Red Ground

7 Green Ground

8 Blue Ground

9 N/C

10 Ground

11 Reserved

12 Reserved

13 Horizontal Sync Output: TTL level (0 to 3.5 V: 10 mA); Negative 
True -31.9 kHz

14 Vertical Sync Output: TTL level (0 to 3.5 V: 10 mA); Positive True - 
70 Hz

15 Reserved

5 4 3 2 1

15 14 13 12 11

10
9 8 7

6
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PCS Assembly Input/Output Connectors

PD (BNC Connector)

AMP Out (BNC Connector)

Input (SHV Connector)

Bias (SHV Connector)

Power (9 pin D Male)

PD Output: TTL level: (0 to 3.5 V @ 24 mA)

AMP OUT Output: Analog level: 0 to 5V @ 10 mA (for test only)

INPUT Input/Output: Analog level: 0V to 2600V @ 110 µA maximum

BIAS Input: Analog level: 0V to 2600V @ 260 µA maximum

Pin number Signal Description

1 HVSET Input: Analog level: 0 to 12V @ 6 mA

2 LLD Input: Analog level: 0 to 12V @ 6 mA

3 HVINT Input: TTL level (0 to 3.5 V: 10 mA)

4 -15V Input: -15V @ 400 mA maximum

5 SCAL Output: TTL level (0 to 3.5 V: 24 mA)

6 ULD Input: Analog level: 0 to 12V @ 6 mA

7 Ground

8 Ground

9 +15V Input: +15V @ 400 mA maximum

1 2 3 4 5

6 7 8 9
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Installing P-10 Gas
The flow proportional counter requires a special gas called P-10. Tanks of P-10 gas are 
available from local bottled gas suppliers. The tank of P-10 should have a two-stage 
regulator with a 1/4 NPT fitting to accept the NORAN-supplied third stage regulator.

WARNING: P-10 gas is a HAZARDOUS MATERIAL. Handle P-10 gas in 
accordance with the manufacturer’s Material Safety Data Sheet.

WARNING: Fasten the tank of P-10 gas securely to a fixed object, such as a 
wall or workbench, to avoid damage to the tank. The tank contains 
hazardous material under pressure. The tank is dangerous if its 
valve is damaged or the tank is punctured. 

Tools
The following tools are necessary for the installation:

• 5/8-inch open-end wrench

Instructions

1. If a two-stage regulator is not installed on the P-10 gas bottle, install it now.

2. Wrap the open end of the 3-inch brass nipple with TeflonTM tape.

3. Remove the 1/4 NPT plug on the two-stage regulator and attach the third stage regulator in 
this opening.

4. Close the valves on the two-stage and third-stage regulators.

5. Open the valve on the bottle of P-10 gas. Make a note of the total pressure.

6. Open the second stage regulator valve.

7. Open the third stage regulator to a reading of 2 psi on the valve on the supplied gauge.

8. Close the bottle of P-10 gas.

9. Attach an in-line filter to the outlet side (top) of the flowmeter. Make sure that Teflon tape is 
used on all fitting connections.

10. Attach the flow meter inlet (bottom) hose barb to the hose barb on the third stage regulator.

11. Attach tubing from the flow meter, filtered, outlet barb to the spectrometer.

12. Attach a small length of tubing from the vent barb and place it in a small beaker of water.

13. Open up the main valve of the tank of P-10 gas. There should be 2-3 bubbles every second 
coming from the tubing in the beaker.

14. Remove the tubing from the beaker of water.
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Maintenance

Converting Input to 230-Volt AC for Europe
The switching power supply has a universal input autoranger that eliminates the requirement 
of changing jumper wires or switches to change the input voltage range. Nevertheless, the 
correct fuse(s) must be installed according to the input AC voltage.

• For 100/120 VAC operation, use one T 250V 3A fuse

• For 230/240 VAC operation, use two T 250V 2A fuses (5x20mm)

Parts Required
• Fuses: 2A 5x20 mm fuses (2A T 250V), quantity = 2. NORAN Instruments part 

number 510A126840

• Continental European power cord, quantity = 1. NORAN Instruments part 
number 600A125780

Procedure

1. Remove the fuse block/cover in the Corcom PEM using a small blade screwdriver or similar 
tool.

2. Remove the fuse and unscrew the fuse holder form the plate.

3. Flip the fuse holder over so that it can accommodate the two 5x20mm fuses.

4. Insert the 2A T 250V fuses and screw back together.

5. Replace the fuse block/cover in the Corcom PEM.

6. Connect the Continental European style power cord to the PEM.

Changing a Blown Fuse in the Controller Switching Power Supply

Parts Required
4A Normal Blow − Type 3AG 250V (Littelfuse 312004 or equivalent)
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Fuse Location
The fuse (designator F1) is located on the power supply circuit board adjacent to 
terminal strip TB1.

Procedure

1. Remove the detachable Ac power cord from the controller.

2. Remove the cover screws and cover.

3. Remove the cable clamp from the base of the chassis near the air baffle.

4. Remove the following DC power harness connectors:

• P11 − 12-pin plug from the PC motherboard

• FD − 4-pin plug from the floppy drive.

• P3 − 2-pin plug from the regulator board

• P4 − 12-pin plug from the regulator board

• P1 − 5-pin plug from the ECS board

5. Move these plug ends alongside the power supply.

6. Remove the four fan bracket screws and the six air baffle screws.

7. Remove the fan bracket and the air baffle.

8. Remove the two screws (8/32-by-38-inch) from the front panel to free the power supply.

9. Lift up the power supply and rotate it out of the chassis.

10. Remove the four corner screws from the power supply cover and remove the cover.

11. Remove the two screws holding the autorange adapter to the power supply sheet metal frame. 
Carefully set it aside.

NOTE: The mounting surface is covered with thermal grease.

V4+
V4-

V3-

V3+
V2+

V2-
S -
V1+
V1+
V41
V1+
S +

V3
ADJ

V4
ADJ

V1
ADJ

PFD
ADJ

LINE
NEU
GND

TBI

115/230 VAC
jumper

Connected
to autorange
 adapter

F 1, 4A Normal 
Blow type 3AG 
250V

input and output barrier strips are equipped with 6-32
screws and accept up to a .25-wide lug.
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12. Find the F1 fuse under the former position of the autorange adapter.

13. Pull the existing fuse out of its holder and insert the replacement.

14. Reverse the above procedure to reassemble the controller. Be careful not to pinch wires when 
you install the fan.
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2 – WDS Software Revisions

Version 3.1.2 Revisions
Revision Notes for Thermo NORAN WDS Software Version 3.0.1, April 18, 2001

New Windows Software Features
15. A new method for setting up default detector bias voltages for each x-ray line has been added 

to the WDS software for the IbeX, MAXray and MAXray ER. Instead of making measurements 
at boron and silicon energies, computing the slopes and intercepts, and then entering them in 
the drtwds.ini file, this new method requires only one measurement, and the measured data 
can be entered directly into the WDS program (See “Bias Offset Correction” in the IbeX or 
MAXray Installation and Support Manual).

This feature can be turned On or Off in the new Bias Offset dialog box. The Bias Offset dialog 
box is opened from the new Service > Bias Offset menu selection.

16. During hardware installation it is no longer necessary to make the Baseline Slope and 
Intercept measurements. All baseline values now default to 0.3 volt in this new software 
version.

17. The turret move commands have been added to the Service > Send To dialog box.

18. The EMSA file format containing XY data types used by the Vantage software can now be 
loaded. 

NOTE: EMSA files cannot properly be loaded as overlay 
spectra.

Windows Software Changes

1. The Edit > Scan Parameters dialog box now remembers the last element whose data was 
displayed and uses this when this dialog box is opened.

2. The program no longer puts up a message box when hardware is being initialized for a WDS 
acquisition during quantitative analysis.

Windows Software Fixes

1. When the Edit > Scan Parameters dialog box was opened, the scan parameters for the 
element Be was displayed. If a Be diffractor was not installed on the turret, the dialog box 
would not permit any other element's parameters to be edited. This has been corrected in 
version 3.1 by using the last element's data as the opening data displayed. The first time this 
dialog box is opened, it displays the parameters for the lowest atomic number element that is 
available on the particular instrument.
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2. The default background energy positions used in quantitative analysis were valid for the 
MAXray, whose high energy range limit is 2 keV. With the introduction of the MAXray ER, we 
discovered that the calculation of the background positions for peak energies above Si did not 
give valid values. This has been corrected in version 3.1 and the new default values are 
computed when the Restore All button in the Edit > Scan Parameters dialog box is used. The 
values for one element at a time may be set by clicking on the Restore (atomic symbol) button 
in this dialog box.

It is necessary to click the Save button to record these new settings.

3. When performing combined EDS-WDS quantitative analysis, the WDS peak background is 
now subtracted correctly.

4. The program now prints properly to a printer setup for 600 dpi.

5. The LiF energy range in the Settings > Configuration dialog box is now displayed correctly.

Verision 3.2.1 Controller Software

Features

1. Now Controls both the IbeX and MAXray in the same program.

2. Controls the new Beam Current Meter if it is installed. See Chapter 6 – Beam Current Option 
(Model A214).

3. New commands have been added to control the Beam Current Meter.

4. Displays run time diagnostics using 25, 30, 43 or 60 rows.

Version 3.0.0 Revisions
Revision Notes for Thermo NORAN WDS Software Version 3.0.0, February 18, 2000.

New Windows Software Features

1. The new NORAN Beam Current Monitor is now supported, both manually, through the use of 
the Settings > Beam Current dialog box, and automatically in the quantitative analysis section 
of the software. Both beam current and specimen current can be measured, and if the 
microscope supports a mechanically operated Faraday cup, it can be activated automatically 
by the software.

2. Support has been added for the integration of the IbeX and MAXray WDS systems in the 
Vantage software. This includes both qualitative and quantitative analysis.

3. The user entered parameters in the Edit > Acquisition Information dialog box are retained for 
use in the next scan automatically unless they are cleared.

4. One or both of the overlay spectra Acquisition Information parameters can be printed along 
with the foreground spectrum parameters beneath the spectrum. Print Preview can be used to 
view the overlay spectra acquisition parameters.

5. The Controller software now displays all boot sequence tests along with information that 
identifies whether a particular test passed or failed.
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6. The elements labeled by the user are now added to the spectrum file. When the file is loaded, 
this information is used to label the peaks. Older spectrum files can still be read, but only the 
new file format is used when saving spectra. The EMSA file format has also been changed to 
allow saving and loading of labeled elements. Any previously stored EMSA files can also be 
loaded with this version.

7. The calibration information is now passed from the controller to the Windows computer when 
the system configuration is read.

8. The Send Command dialog box now has a list box of commands to select from.

9. There are now four distinct sounds corresponding to Ok, Problem, Alert and Question.

These sounds can be toggled ON or OFF from the Options menu.

10. The Peak Search dialog box has been enhanced to now include settings for the scan range, 
step size and dwell time.

11. The peak position found using the Peak Search scan can now be recorded and used as the 
default energy for the selected element.

12. Communication ports COM3 and COM4 can now be used, along with COM1 and COM2, to 
operate the spectrometer controller. This allows the WDS software to be used along with a 
wider variety of NORAN applications.

Version 3.0.0 Changes

1. The Windows program version number and the Controller software version number now 
match, making it easy to identify compatible versions of both.

2. More space has been allocated for displaying the file name in the Edit >  Acquisition 
Information dialog box, and when printed, the file name appears without the path.

3. The Service > Turret Scan menu selection is disabled for IbeX spectrometers after the Service 
> Initialize Motors function has been performed.

4. The Settings > Beam Current menu selection is disabled when a beam current meter is not 
attached to the controller. 

5. The default file name extension for a spectrum file has been changed from .wds to .wdx to 
eliminate confusion with the Vantage software. The original .wds type of files can still be 
loaded, and both .wds and .wdx file names are displayed in the Open File dialog box list. Only 
.wdx type files can be saved from the Save and Save As menu selections.

6. The Rate Meter Smooth check box is checked by default whenever the Rate Meter dialog box 
is opened.

7. The diffractor name is now displayed when moving the cursor over the Periodic Table.

8. The Configuration dialog box can be left open while the application is running.

9. The ‘Damp' check boxes in the Rate Meter and Beam Current Meter dialog boxes have been 
changed to ‘Smooth' to better explain the averaging effect.

10. The Rate Meter dialog box has been enlarged to permit better visibility from farther away.

11. The Service menu items requiring a password are grayed out until a password is entered.
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Version 3.0.0 Fixes

1. The memory corruption problems associated with stopping a scan have been corrected.

2. The problems associated with loading and displaying overlay files has been fixed.

3. The ECS card type used in the controller is now recorded correctly.

4. The crystal 2d spacing in the Settings > Configuration dialog box is now reported correctly to 
three decimal places.

5. The analog rate meter no longer plots below the zero baseline.

6. All selected acquisition parameters are now printed along with the spectrum, and the 
parameter names printed match those in the Edit >?Acquisition Information dialog box.

7. The loaded spectrum now changes its file name to reflect the path it was loaded from.

8. No elements are highlighted when the Scan Periodic Table dialog box is opened.

9. The program no longer crashes on exit using the File > Exit menu item.

10. The controller now allows you to add and save the first calibration point when starting a 
calibration sequence.

11. Old spectrum files will not be over—written without a warning.

12. The filename extension is now only added if it is not entered as part of the name.
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3 – MAXray Parallel Beam Spectrometer

Ultrahigh Resolution and Intensity at Low Beam Voltage
The new MAXray Parallel Beam Spectrometer is a revolutionary new product that 
extends the power of microanalysis for FESEMs and defect review tools.

The MAXray spectrometer is ideal for microanalysis, especially for the analysis of low 
energy x-ray lines. A NORAN Instruments’ exclusive reflective optic placed close to the 
sample, like a solid state detector, converts a divergent beam of x-rays to a parallel 
beam. Parallel Beam Spectrometry (PBS) combines the resolving properties of 
wavelength-dispersive spectrometry with the sensitivity of a large area energy-
dispersive detector.

The combination of detector design and proximity to the sample used in PBS provides 
great improvement in low energy resolution and sensitivity over energy-dispersive 
spectrometry.

The MAXray is integrated with the VOYAGER/VANTAGE Defect Analysis and EasyEDS 
software. When a peak overlap appears in an EDS spectrum, an ultrahigh-resolution 
scan is performed over the region in question and a new spectrum window is opened to 
display the results in a familiar energy scale. The overlapped EDS peaks are then 
accurately identified and labeled using the MAXray scan results.

Applications
The MAXray Parallel Beam Spectrometer is ideal for applications that require superior 
light element x-ray detection, and for applications that use low beam currents and 
accelerating voltages, such as: 

• analysis of small particles

• analysis of beam-sensitive samples

• thin film analysis

In addition to unequaled intensity performance for Be, B, C, N, O, and F, the MAXray 
spectrometer also identifies overlapping peaks for materials or applications such as:

TiN WSi2 CrO

N and Ti O and V O and Cr

F and Fe Na and Zn Si and W

Si and Ta
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Interface
Because of its innovative design, the MAXray spectrometer interfaces with virtually any 
defect review tool or SEM. A manually operated gate valve is offered as an option to 
provide vacuum isolation between the MAXray and the SEM chamber.

MAXray Specifications

MAXray Spectrometer
• NORAN Instruments, exclusive grazing incidence reflective x-ray optic

• Sample-to-optic distance: 20 mm for improved solid angle for light elements

• Optic optimized for 100 eV to 1.8 keV detection

• Improvement in intensity (counts/second/nanoamp) of up to 50 times over 
conventional wavelength-dispersive spectrometers, depending on the element 
of interest

• Horizontal or vertical orientation. In a vertical mount, the narrow profile creates 
no interference with instruments on other ports.

• Parallel x-ray beam allows the use of large, flat, undistorted diffractors

• Solid angle of x-ray collection is determined by the distance from the sample to 
the x-ray optic, and is unaffected by the distance to the diffractor

• Retractable slide for use when the optic must be moved away from the sample

• The MAXray spectrometer converts a divergent beam of x-rays to a parallel 
beam, so no slit is needed. High resolution is maintained without sacrificing 
count rate.

• Broadband x-ray optic and 6-diffractor turret to cover the energy range of 100 
eV to 1.8 keV

• Gas flow proportional counter with integrated pulse processing electronics

• Reliable and proven in-vacuum servomotor positioning of the detector and 
diffractors

• Independent microprocessor controller for movement and data acquisition

• Optional gate valve for isolation from the microscope column

• Backed by the NORAN Instruments support network
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Control and Data Acquisition Electronics
• Controller − Electronics and 3-axis motor controller in single tower format

• Timer − 0.1 second resolution, 9,999 seconds (max), 

• SCA counter − 650,000 cps (max.), 9,999,999 counts (max.), Control DACs for 
bias, baseline, window

• Dot mapping − Analog only, providing TTL pulse output, 1-50 µs duration

• Data acquisition electronics − Integrated preamplifier, amplifier, single channel 
analyzer (SCA) and bias supply, Remotely programmable baseline, window and 
HV bias, Baseline and window programmable over full range of amplifier

• SCA output −TTL pulse, 300 ns width, Analog amplifier output: 0-5 volt, 
Gaussian

• HV bias supply − 1325-2600 volts

Software
• Fully integrated with VOYAGER and VANTAGE Defect Analysis and EasyMicro 

software

• Automatically launches in overlap conditions

• Automated calibration

• Automatic peak identification and labeling

• Prior experience with WDS is not required for operation

• Additional software training is not required

• Built-in manual override of all acquisition parameters

• Spectral display in energy units (keV)

• Energy cursor and KLM markers

• Peak ID hinting

• Resizable window for ease of use on the desktop

• Convenient menu selections for loading and saving data

• Pre formatted printouts for fast report generation

• Physical Dimensions (approximate)

• Spectrometer − Max. 17.50 W X 11.88 H X 6.19 D in.; 44.5 W X 30.2 
H X 15.8 D cm.

•  Weight − 57 Ib (26 kg).

• Controller, tower format − 9 W X 15 H X 23 D in.; 23 W X 38 H X 58 D cm.
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MAXray - Standards

MAXray ER Specification

Notes

1. The NORAN smaple standards are part number 555A135192.

2. “NOR” is a multi-layer synthetic diffractor.

3. Resolution is Full Width Half Maximum (FWHM).

4. Intensities are peak counts normalized to time and beam current measured with a Faraday 
cup.

5. Background positions for synthetic diffractors are peak energy +1/5λ , and peak energy + 2/
3(K_-Kb) for natural diffractor.

Element/Line Standard Diffractor keV FWHM(eV) CPS/nA

Be K Be 0V200H 10 6 600

B K B 0V200H
0V145H

10
16
9

6000
4400

C K C 0V100N
0V080E

10 13
11

6000
1280

N K BN 0V080E 10 9 474

O K SiO2 0V060 10 12 336

Fe L Fe 0V060
TAP

10 185
32

Mg K Mg TAP 10 477

Si K Si TAP 10 15 300

Spectral 
Line (a)

Elemental 
Standard1

Energy 
(keV)

Diffractor2
Acclerating 

Voltage 
(keV)

Resoluction3 
(eV)

Intensity4 
(cts/sec/nA)

Peak-to-
Background

CDL
5 

(ppm)

Be Pure Be 0.108 NOR200H 5 11 546 69 54
B Pure B 0.185 NOR200H 5 16 5000 56 20
B Pure B 0.185 NOR80N 5 9 1100 43 48

C Pure C 0.282 NOR80N 5 16 3000 113 18
N BN 0.392 NOR80N 5 19 62 5 591
N BN 0.392 NOR80N 5 16 530 20 101

O SiO2 0.523 NOR60A 5 17 208 40 114
Al Al 1.487 TAP 10 21 485 241 30
Si Si 1.740 TAP 10 26 416 255 32

Si Si 1.740 PET 10 8 264 796 23
Sc Sc 4.090 PET 10 38 40 107 160
Fe Fe 6.403 LiF 20 46 147 193 62

Cu Cu 8.046 LiF 30 62 159 157 66
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6. Concentration Detection Limit (CDL) is calculated using the following formula (Ziebold, 1967):

CDL > 3.29/(T x P x P/B) 1/2

Where: T= total count time (1000 seconds)

P= peak count rate (0.1 uA specimen current)

P/B= Peak-to Background ratio

7. Guaranteed values are 80% of published specifications.

8. Data is collected with a smooth, flat specimen and x-ray take-off angle of 35o.
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Schematic Diagram of PBS Spectrometer
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MAXray Allowable Bragg Angles for Various Diffractors

keV Element Line Lambda (A) 2d= 200 160 145 120 100 80 60 50 45 35 25.75 (TAP) 13.4 (KAP) 8.742 (PET)

0.109 Be K 113.747 4.0000 45.3097 51.6710
0.185 B K 67.016 19.5775 24.7621 27.5279 33.9499 42.0796 56.8983
0.282 C K 43.965 15.9488 17.6501 21.4920 26.0813 33.3366 47.1168 61.5569
0.331 Mo M 37.456 18.1879 21.9972 27.9177 38.6286 48.5145 56.3419
0.341 Ca La 36.358 17.6368 21.3201 27.0310 37.2982 46.6485 53.8962
0.355 Nb Mg 34.924 20.4408 25.8839 35.5960 44.3051 50.9037
0.392 N K 31.628 18.4378 23.2875 31.8115 39.2386 44.6549 64.6413
0.395 Sc La 31.387 18.2928 23.1003 31.5419 38.8841 44.2265 63.7381
0.452 Ti La 27.429 15.9198 20.0515 27.2036 33.2699 37.5561 51.5998
0.461 Ru Mg 26.894 15.6010 19.6438 26.6301 32.5390 36.7009 50.2097
0.496 Rh Mg 24.996 18.2069 24.6201 29.9947 33.7428 45.5753
0.511 V La 24.262 17.6546 23.8517 29.0285 32.6265 43.8845
0.523 O K 23.706 17.2367 23.2717 28.3015 31.7888 42.6331 67.0145
0.532 Pd Mg 23.305 16.9362 22.8555 27.7808 31.1900 41.7470 64.8273
0.568 Ag Mg 21.827 15.8335 21.3332 25.8839 29.0161 38.5826 57.9590
0.573 Cr La 21.637 15.6918 21.1381 25.6416 28.7391 38.1848 57.1688
0.606 Cd Mg 20.459 19.9365 24.1530 27.0417 35.7702 52.6094
0.637 Mn La 19.463 18.9283 22.9083 25.6272 33.7857 49.0996
0.677 F K 18.313 17.7713 21.4853 24.0139 31.5493 45.3318
0.691 Sn Mg 17.942 17.3997 21.0291 23.4978 30.8393 44.1693
0.705 Fe La 17.586 17.0435 20.5923 23.0040 30.1623 43.0742
0.733 Sb Mg 16.914 16.3737 19.7722 22.0780 28.8984 41.0606
0.776 Co La 15.977 15.4430 18.6349 20.7959 27.1602 38.3496
0.778 Te Mg 15.936 15.4023 18.5852 20.7400 27.0847 38.2332
0.833 La Ma 14.884 17.3178 19.3140 25.1661 35.3101
0.848 Ne Ka 14.620 17.0020 18.9592 24.6909 34.5954
0.851 Ni La 14.569 16.9403 18.8899 24.5980 34.4562
0.883 Ce Ma 14.041 16.3089 18.1808 23.6510 33.0433
0.929 Pr Ma 13.346 15.4805 17.2515 22.4143 31.2165
0.930 Cu La 13.331 15.4635 17.2324 22.3889 31.1792
0.972 Ba Mg 12.755 16.4661 21.3727 29.6925
0.978 Nd Ma 12.677 16.3622 21.2352 29.4923
1.012 Zn La 12.251 15.7979 20.4890 28.4093
1.041 Na Ka 11.910 15.3468 19.8938 27.5494
1.081 Sm Ma 11.469 19.1284 26.4488 58.8589
1.098 Ga La 11.291 18.8210 26.0084 57.4205
1.131 Eu Ma 10.962 18.2522 25.1955 54.8909
1.185 Gd Ma 10.462 17.3932 23.9732 51.3320
1.188 Ge La 10.436 17.3479 23.9088 51.1516
1.240 Tb Ma 9.998 16.5988 22.8479 48.2578
1.253 Mg Ka 9.895 16.4217 22.5977 47.5959
1.282 As La 9.671 16.0401 22.0593 46.1953
1.293 Dy Ma 9.589 15.9000 21.8619 45.6894
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1.347 Ho Ma 9.204 15.2467 20.9432 43.3834
1.379 Se La 8.991 20.4352 42.1395
1.405 Er Ma 8.824 20.0407 41.1873
1.462 Tm Ma 8.480 19.2279 39.2606
1.480 Br La 8.377 18.9851 38.6933
1.486 Al Ka 8.343 18.9055 38.5082
1.521 Yb Ma 8.151 18.4545 37.4667
1.581 Lu Ma 7.842 17.7304 35.8181 63.7709
1.586 Kr La 7.817 17.6727 35.6879 63.4066
1.644 Hf Ma 7.541 17.0298 34.2488 59.6164
1.694 Rb La 7.319 16.5125 33.1051 56.8453
1.709 Ta Ma 7.255 16.3635 32.7778 56.0832
1.740 Si Ka 7.125 16.0640 32.1230 54.5937

keV Element Line Lambda (A) 2d= 200 160 145 120 100 80 60 50 45 35 25.75 (TAP) 13.4 (KAP) 8.742 (PET)
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4 – Overview of Parallel Beam Spectrometry and WDS
Parallel beam spectrometry (PBS) provides significant gain improvements over 
wavelength-dispersive spectroscopy (WDS) on SEMs. WDS in turn provides 
dramatically better resolution and sensitivity than its energy-dispersive (EDS) 
counterpart. Because EDS is so widely used, many new SEM users may not have had 
an opportunity to use WDS, and PBS is such a new development that it might be 
unfamiliar. The following table summarizes differences among the techniques:

PBS WDS EDS Significance

Operating
principle

Geometry and crys-
tal diffraction allow 
only photons of a 
particular wave-
length to arrive at 
the detector, which 
counts photons. It 
does not measure 
energy. PBS uses a 
special optic and 
flat crystals, and 
uses a larger solid 
angle than WDS.

Geometry and crys-
tal diffraction allow 
only photons of a 
particular wave-
length to arrive at 
the detector, which 
counts photons. It 
does not measure 
energy.

Current induced in 
the detector is pro-
portional to photon 
energy. The detec-
tor determines pho-
ton energy, and 
counts and sorts 
photons by energy.

Although one tech-
nique measures 
photon energy and 
the other measures 
wavelength, the 
results are the 
same, because 
these two parame-
ters are directly 
related.

Energy/wave-
length range

A WD spectrometer 
is tuned to one 
energy at a time

A WD spectrometer 
is tuned to one 
wavelength at a 
time.

An EDS detector 
counts photons of 
all energies. It eval-
uates all energy lev-
els at the same 
time.

EDS provides faster 
but less accurate 
results, which is 
especially useful for 
data-intensive anal-
ysis such as map-
ping.

Detector
Resolution

WDS resolution is 
limited by calibra-
tion accuracy – res-
olution on the order 
of 24 eV for manga-
nese.

WDS resolution is 
limited by calibra-
tion accuracy – res-
olution on the order 
of 24 eV for manga-
nese.

EDS resolution is 
reduced by:
�Noise in the detec-
tor signal current
�Incomplete conver-
sion of photon 
energy to signal cur-
rent
�Resolution accu-
racy on the order of 
130 to 140 eV for 
manganese

WDS can resolve 
peaks more pre-
cisely than EDS, 
which is especially 
useful when over-
lapping peaks are a 
problem. Depend-
ing on the diffractor 
and element 
selected, resolu-
tions of 2 eV to 25 
eV are possible with 
WDS.
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This chapter covers the principles of WDS, describes the dramatic gain increases 
available with PBS, and provides some examples of PBS capabilities with MAXray.

Deadtime WDS deadtimes are 
short because the 
detector only needs 
to count, not mea-
sure, photons.

WDS deadtimes are 
short because the 
detector only needs 
to count, not mea-
sure, photons.

EDS deadtimes are 
longer than those 
for WDS. In an ana-
log system, dead-
times 100 to 1,000 
times larger than 
WDS are typical.

Higher throughputs 
are possible with 
WDS.

Element Limits Detects all ele-
ments with x-ray 
lines below 2 KeV.

Detects all ele-
ments having 
atomic numbers 
greater than or 
equal to beryllium, 
depending on crys-
tal materials and 
position.

Detects all ele-
ments having 
atomic numbers 
greater than or 
equal to beryllium, 
depending on crys-
tal and window 
materials.

Both EDS and WDS 
can detect all ele-
ments except hydro-
gen, helium, and 
lithium.

Detection
limits

Roughly on the 
order of 0.1 to 0.01 
weight percent, 
depending on the 
element, or about 
10 times better 
peak-to-back-
ground ratio than 
EDS.

Roughly on the 
order of 0.1 to 0.01 
weight percent, 
depending on the 
element, or about 
10 times better 
peak-to-back-
ground ratio than 
EDS.

Roughly on the 
order of 1.0 to 0.1 
weight percent, 
depending on the 
element, the detec-
tor, the sample, and 
other conditions.

Use WDS for trace 
element analysis.

Ease of use PBS is used only for 
qualitative analysis.

WDS needs fine 
tuning for high pre-
cision, and element 
standards are 
required for quanti-
tative analysis.

Many applications 
can be fully auto-
mated and EDS can 
perform standard-
less quantitative 
analysis.

For quantitative 
analysis, WDS 
requires more 
attention than EDS.
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Principles of WDS 
WDS is based on Bragg's law of x-ray diffraction: 

Bragg's law: nλ= 2d sinθ Equation 1

where  λ is the wavelength of interest 
d is the interplanar spacing of the diffractor
θ is the angle of x-ray incidence on the diffractor 
n is an integer 

and, E (keV) = 12.398/λ Equation 2 

NOTE: In Equation 2 that Energy and Wavelength are inversely 
related: short wavelengths are high energy. It is often a source of 
confusion when EDS users look at a conventional wavelength spec-
trum and see a Kβ to the left of a Kα. Here, spectra will always be dis-
played with energy increasing to the right. 

The classic derivation of Bragg's law is as follows. Consider that a parallel beam of x-
rays of wavelength λ is made incident on a material whose structure comprises a 
precisely parallel arrangement of planes (atomic, molecular, or otherwise), with 
interplanar spacing, d:

Figure 4-1: Bragg’s law derivation

Wave 1 is reflected into 1' from the top plane in the diffractor (or “crystal”) with the angle 
of incidence, θ, equal to the angle of reflection. Wave 2-2', being reflected from the lower 
plane, travels an extra distance in the material equal to dsinθ + dsinθ. For an intense 
diffracted beam to result, wave segments 1' and 2' must be in phase; which, in turn, 
requires that the extra path length traveled by wave 2-2' must be an integral number of 
wavelengths: that is, 2 (dsinθ) must equal nλ. 

d

qq

dsinθ dsinθ

X-Ray 1

X-Ray 2

1’

2’
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If Bragg's law is satisfied, then the emerging waves will add in strength. If not, there will 
be destructive interference, with one wave cancelling another, and only a very weak 
beam will result. As the crystal is scanned through an angular range, the diffractor 
becomes a highly reflective mirror only at the Bragg angle; the specificity of the angle of 
high reflectivity is the key to the high resolution of WDS. 

WD spectra are acquired by scanning a diffractor and detector through a range of 
angles. As Bragg's law is satisfied for various wavelengths being emitted from the 
sample, sharp peaks result. Peak width is typically from 2 to 25 eV, compared to 80 to 
160 eV in EDS. High resolution leads to high peak-to-background ratio (P/B), P/B 
controls sensitivity and minimum detection limits for both analysis and mapping. 

Since the angle of incidence equals the angle of reflection, a detector or counter must 
be positioned at the same angle relative to the diffractor as the incident x-ray beam 
makes with the diffractor itself. Relative to the incident beam, the diffractor is at an angle 
θ, and the detector at 2θ.

In the derivation of Bragg's law, a parallel beam of x-rays was assumed. In the SEM, 
however, use of a spot or high magnification raster means that the beam starts 
essentially at a point and diverges on its way to the diffractor. 

In PBS, a special collimating optic is placed close (20 mm) to the surface of the sample. 
Divergent x-rays passing through this optic are converted into a parallel beam of x-rays. 
This beam strikes a large, flat diffractor and is diffracted into the window of a gas-filled 
proportional counter. Since the parallel beam does not have to be focused, as in 
conventional WDS, the distance between the sample and diffractor does not have to 
equal the distance between the diffractor and the detector window, allowing the detector 
to be moved closer to the diffractor. The Bragg angle relationship still must be met, 
though.

Implications of the nature of PBS:

1. Compared with EDS, resolution is typically an order of magnitude better; peak overlaps are 
virtually eliminated. 

2. The high resolution leads to order-of-magnitude better sensitivity than EDS. The sensitivity 
improvement is often most dramatic in the light element region.

3. The better P/B and elimination of overlaps yield more accurate quantitative analysis for those 
elements in low concentration or involved in the overlap.

4. Because the WD spectrometer can be positioned at the center of the peak, where P/B is 
maximized, WDS provides superior x-ray maps, especially for low concentrations.

5. Due to the serial nature of spectrum acquisition, qualitative analysis is slow compared to EDS. 

6. The large solid angle achieved using the PBS optic yields a greater sensitivity to light element 
energies than conventional WD.

7. WDS is often operated by driving the crystal directly to the peak, with or without peak 
searches. In this manner, the counting time is devoted only to the points of real interest. For 
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minor elements, WDS then becomes fast relative to EDS, which spends most of its time 
counting x-rays from the major elements. 

X-ray Optics

Diffractors
The term “crystal” is routinely used to describe the diffractor and, in fact, the device is 
commonly called a “crystal spectrometer.” However, the prominence of the new 
multilayers, which have greatly improved light element analysis, makes the general term 
diffractor more appropriate. The term “crystal” implies a regular arrangement or 
stacking of atoms or ions to form the crystalline structure of metals and minerals. The 
very efficient multilayer, in fact, are not crystals but rather vacuum-deposited alternating 
layers of different materials. The “interplanar spacing” is the thickness of the lower 
atomic number “spacer,” while the diffracting planes are the layers of the higher-Z 
material. Although both terms will be used here, “diffractor” is preferred.

The commonly used diffractor are listed in the table below. Since Bragg’s law contains 
the quantity “2d”, diffractors are typically described by their 2d value.

NOTE: The multilayers can be manufactured to any specified 2d 
value, within, approximately, the ranges shown. 

The crystal d-spacing must be of the same magnitude as the wavelength of the x-ray to 
be measured. For example, the CKα x-ray, at 0.282 keV, would require NiC (a synthetic 
crystal) with a 2d value of 100 angstroms. The SiKα x-ray, at 1.74 keV, would require 
TAP (a natural crystal) with a 2d value of 25.75 angstroms.

A practical requirement in crystal selection is that diffraction must occur within the 
angular range of the spectrometer. The maximum angle allowed in the MAXray is 68�, 
and the minimum angle is 14�. If CKα, at 0.282 keV, is to be analyzed, the NiC (2d=100 
angstroms) is suitable. Using Bragg's law (Equation 1), the CKα peak on NiC is at 
25.26�.

Performance is another consideration in choosing a diffractor. Consider one of the more 
involved choices, that for boron, specifically, and for light elements in general.

Designation Full Name 2d, A

PET Pentaerythritol tetrakis 8.742

TAP Thallium “acid” phthalate 25.9

W/Sii Tungsten/Silicon Multilayer* 50-65

Ni/C Nickel/Carbon Multilayer* 80-100

Mo/B4C Moly/Boron Carbide Multilayer 140-205
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Detectors
Wavelength spectrometers almost exclusively use gas proportional counters. X-rays 
diffracted from the crystal enter the counter and cause ionization of the contained gas. 
There is a central wire along the height of the detector (in a direction normal to the 
sample-crystal-detector plane, parallel to the crystal width), to which a bias voltage of 
typically +2000 volts is applied. The electrons freed by the ionization process then are 
accelerated to the wire, creating new ionizations in their path, ultimately producing a 
current pulse that is proportional to the energy of the absorbed x-ray. As in EDS, the 
current pulse is converted to a proportional voltage pulse in an field-effect transistor 
(FET), amplified, converted to a digital signal and counted. Unlike EDS, however, the 
FET is held at room temperature, and the digitizing is done in a single channel analyzer 
(SCA) rather than in an analog-to-digital converter (ADC). The EDS system's ADC must 
retain the proportionality to the original x-ray energy, so that a count can be stored in the 
appropriate channel of a multichannel analyzer. In WDS, the resolution is achieved by 
the diffractor, and the SCA simply allows selection of the upper and lower limits of the 
size of the amplified voltage pulse that will be counted. 

Since the counter contains a gas, a window must be used to isolate the inside of the 
detector from vacuum; if low energy x-rays are to be analyzed, the window must be thin. 
The detector is called a gas-flow, or flow proportional counter (FPC). An Argon-10% 
methane mixture, called P-10 Gas, is the normal counter gas.

Some fully focusing spectrometers use a dual counter system, with the SPC directly 
coupled to and behind the flow counter. An exit window in the FPC allows unabsorbed 
higher energy x-rays to enter and be counted in the SPC. About 2/3 of the CuKα 
intensity, for example, will come from the rear counter.

The speed and low noise characteristics of the proportional counter account for two 
additional advantages of WDS over EDS:

1. The counter can handle very high count rates, up to about 10 Kcps, without dead time, or even 
up to 100 Kcps in some cases. If the spectrometer is set to a peak position, and say 20 Kcps 
can be achieved, all that count-rate is in the element of interest. Compare this to EDS, which 
may be limited to a few thousand counts per second over the entire spectrum.

2. Its low noise contributes to the excellent light element capability of WDS. EDS detectors, 
which are cooled to near-liquid nitrogen temperatures to reduce inherent thermal noise, 
continue to fight that noise as their application is stretched to lower low-energy thresholds. 
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Spectrometers

Interfacing Requirements 
The multielement spectrometer can be adapted to any SEM chamber. Since crystals 
remain within the spectrometer housing, only a very small port is required.

The IbeX Multielement Spectrometer
In addition to the MAXray spectrometer, NORAN offers another dispersive spectrometer 
called IbeX.

In the IbeX multielement device, L is fixed, and the diffractor simply rotates to achieve 
the desired angle with the incident beam. It is the elimination of the L movement that 
gives the multielement spectrometer its defining characteristics. The fixed L: 

• Permits easy interfacing to nearly any SEM chamber. Since the crystals do not 
enter the chamber, even very small ports can be used.

• Reduces the housing size considerably. The multielement spectrometer is about 
one-third the weight and half the linear dimensions of full-range units.

• Reduces mechanical complexity and therefore cost. The multielement 
spectrometer is about one-half the price of fully-focusing units.

• Restricts its application to specified elements or energy ranges. Although 
focusing is exact for only one wavelength per crystal, small errors in L can be 
tolerated, which means that good performance can be maintained over several 
degrees of scanning.

For the elements designated (one per crystal), expected WDS performance is achieved. 
For the light elements, performance can even be superior to fully focusing units, 
because the best diffractor can be used for each element designated.

In the IbeX, L is typically 20 or 25 cm (8 or 10”) depending on chamber size. Up to six 
diffractors can be used in a given spectrometer, each optimized for a specific element by 
selection of the best material and d-spacing, and then curved to the radius required by 
the focusing equation. Each diffractor will be curved to a different radius (correct for 
focusing its designated element). (Each diffractor, therefore, is on a unique Rowland 
circle.) The spectrometer permits selection of the diffractor and its rotation to a specified 
angle or through a range of angles. The detector (a flow proportional counter) moves 
along an arc, maintaining a constant detector-to-diffractor distance (L2=L), to its 2θ 
position (see Figure 4-2). Further, if the diffractor is rotated to an angle other than the 
one for the crystal's designated element, Bragg's law can be satisfied, but not the 
focusing equation (since θ changes, but both R and L are fixed). Consequently, 



Spectrometers 4 –  Overview of Parallel Beam Spectrometry and WDS

4-8 MAXray Service and Installation Manual

multielement spectrometers can be scanned through an angular range to pick up other 
x-ray lines, but will suffer loss in performance as the angle deviates from the optimum. 
The larger the deviation, the less results compare favorably with fully-focusing systems. 
Fortunately, however, for moderate scanning ranges, reasonable performance is 
achieved.

Figure 4-2:  Multielement spectrometer motion.

The following spectrum, from albite, was obtained in a multielement spectrometer by 
scanning the TAP crystal through an angular range of about 12�θ.

Figure 4-3:  A mutlielement spectrometer scan, Na-Si.

The improved resolution and Peak-to-background over EDS, despite moving off the 
focusing condition, is significant. Note that, despite the higher Si concentration, the Al 
and Si peak heights are nearly equal, due to the diffractor being optimized, in this case, 
for Al. Crystal radius plays a significant role in the relative peak heights obtained with 
this type of spectrometer. 
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Achieving Required Motions in IbeX
Wavelength spectrometers require precise and repeatable mechanical movements. 
Conventional spectrometers utilize complex mechanical linkages to achieve the relative 
motions of crystal and detector; such linkages are fragile, require frequent adjustment, 
must be moved slowly and are prone to some degree of backlash. The IbeX eliminates 
these linkages, utilizing two in-vacuum encoded brushless servomotors to 
independently position the crystal and detector under computer control. Such motion is 
referred to as positioning by independent parameterization.

WDS Applications
A typical example of a WDS application is described below.

Setting Up TiN
In TiN, the NKα and the TiLα, Lβ lines are separated by only about 58 eV. Since the 
peak resolutions at the nitrogen and titanium energies are only around 30 eV, the two 
peaks can be easily resolved, and a clear distinction can be made between Ti and TiN 
samples without the need for deconvolution.

A few typical examples of WDS applications, from both types of spectrometers, are 
given in the following sections.

Resolution of W, Ta, and Si 
Another common overlap area in EDS is the Si K with the W and/or Ta M lines. The SiKα 
is at 1739 eV, while the W Mα is at 1774 eV, and the Mβ at 1835 eV. Less than 100eV 
separate these three peaks. Ta and Si present an even more severe overlap, with the 
two Ta M lines bracketing the Si peak by 30 eV on the low side and 25 eV on the high 
side.

A difficult analytical problem is found in the analysis of thin Ta- or W-Si films used in the 
semiconductor manufacturing process. Since these films are produced on Si wafers, Si 
emission from the substrate can overwhelm the Si and Ta or W peaks from the film. To 
avoid significant penetration into the film, and the resulting high substrate intensity, a low 
accelerating voltage (less than 10 keV) must be selected. The use of the L-lines of W or 
Ta is thus precluded, and the overlapped M-lines must be used for analysis. Because of 
the severity of the overlap, the quantitative precision required can only be obtained by 
resolving the analyzed peaks, dictating the use of WDS. 
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The following figure shows spectra from TaSi and WSi. In the WSi spectrum there is a 
noticeable indication that two Si satellite lines are present just to the high energy side of 
the Ka. These lines, in fact, are separated by only 2eV (at 1752 and 1754 eV).

Figure 4-4: WDS spectra from TaSi (left) and WSi (right). 
Note the indication of the 2 Si satellite lines, separated by only 2 eV, in the WSi spectrum.

Analysis of Boron In BPSG
BPSG (borophosphosilicate glass) is a thin film used in the semiconductor process. It is 
important to control both the P and B “dopant” levels to insure proper device yield and 
product reliability. WDS is one of the best methods for boron determination in BPSG 
because of its high analytical sensitivity for light elements and its straight forward linear 
response (in this application) to the boron concentration. NORAN's multielement 
spectrometer is one of the primary tools used in the industry to perform the analysis; 
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with the Mo/B4C multilayer, it is, in this instance, the most efficient and cost-effective WD 
system available. Figure 3-5 shows an overlay of 4% and 2% BPSG. In the actual 
analysis, however, peak scans are not done; rather, the spectrometer is simply driven to 
the B peak position, where counts are recorded for standards and unknowns. A typical 
(linear) calibration curve is shown in Figure 3-6.

Figure 4-5: Figure 5: 4% B BPSG overlaid with 2% BPSG.

Figure 4-6: Figure 6: Calibration curve for B in BPSG.
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5 – Vacuum Considerations When Using the 
MAXray Parallel Beam Spectrometer

The MAXray Parallel Beam Spectrometer is a high performance wavelength dispersive 
spectrometer (WDS) utilizing a Grazing Incidence X-Ray Optic to collect and collimate 
x-rays. Like any WDS spectrometer, the spectrometer is open to the vacuum system of 
the electron microscope to which it is attached.   This is unlike an EDS type detector 
where the cryogenic environment of the solid state detector cannot tolerate a direct 
opening to the vacuum system.

The MAXray spectrometer presents an additional load on the vacuum pump system in 
an electron microscope. The spectrometer alone contributes the following “loads:”

Spectrometer Volume: 10.4 L

Spectrometer Surface Area: 3390 sq.cm (Not including mechanisms, motors)

Elastomer Seals: 292 cm

Depending upon the microscope vacuum system present, these additional loads will 
create a higher equilibrium pressure (P=Q/S; where P is the pressure, Q is the 
throughput in outgassing and leaks, and S is the pumping speed.)

In field emission SEMS, vacuum can be a critical operating parameter. In testing on 
various FESEMs, the MAXray spectrometer did produce higher base pressures in the 
microscope chamber, however little to no degradation in the intermediate and gun 
pressure was seen.   The MAXray has been tested up to 5 days on an FESEM without 
causing degradation in the gun vacuum level. Users will have to tolerate higher sample 
chamber pressures when operating a MAXray spectrometer.

Other notes concerning vacuum compatibility.

1. The MAXray spectrometer, by virtue of its unique design, is actually coupled to the microscope 
by a rather poor conductance (3-5 liters/sec). Although this may extend initial pump down, the 
poor conductance limits the actual load seen by the microscope vacuum system.

2. The MAXray spectrometer does utilize the industry standard Gas Flow Proportional Counter 
for detecting diffracted x-rays. To enable detection of low energy photons, a thin polymer 
window isolates the P-10 (Argon/10% methane) from the vacuum system. Any leakage 
through this window will produce an additional load on the vacuum system. Note also in 
spectrometers fitted with a gate valve to isolate the spectrometer during chamber venting 
excessive time isolated from vacuum will cause the pressure to rise in the spectrometer. The 
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pressure rise can be due to both leakage from the flow counter and outgassing from the 
spectrometer surfaces.

3. Depending upon storage and shipping conditions, the initial pump down of a MAXray 
spectrometer can take anywhere from 12 to 36 hours.
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6 – Maintaining a Constant Physical 
Working Distance and Focus

On older SEMs, maintaining the same physical working distance when changing 
specimens or keV can be challenging. It is important that after alignment of the MAXray 
spectrometer, all specimens being analyzed must be located at the same physical point 
in space so that the optic is focused on the specimen surface. The flowchart below 
illustrates the technique used at NORAN Instruments when working with an SEM for 
which the apparent working distance and focus is not compensated when changing keV. 
Additionally, no microscope will compensate the actual WD when changing specimen, 
i.e., electronic focus will change, but the change in specimen height is not compensated.   
Therefore the I specimen could be located outside of the focal plane of the MAXray 
optic.

Note that in the lower loop, you cannot change keV and specimen at the same time.   If 
the loop is broken at any time, you would typically have to return to the baseline 
established during alignment. The user must become proficient in placing the specimens 
to be analyzed at the correct stage position. The use of height setting jigs is strongly 
recommended.

ALIGNMENT OF MAXray:
keV=10.0 Specimen “A”

1. Set electronic focus controls at the midpoint (center coarse and fine focus knobs) of the 
range for the designed working distance for the MAXray being installed (may change for 
each installation - see column drawing.) 

2. Set the PROBE CURRENT. 
3. Clear LENS (de-Gauss lens if available) 
4. FOCUS the specimen image using the fine Z-AXIS STAGE CONTROL ONLY.
5. Note that changing areas on the same specimen can change specimen height and 

focus. Refocus using the stage controls only. 

CHANGE keV
STILL ON SPECIMEN “A” 
To focus image - adjust the 

ELECTRONIC CONTROLS on console 
only.

DO NOT CHANGE Z-AXIS CONTROL 
ON STAGE.

SAME keV
CHANGE SPECIMEN to “B”

Focus image using fine Z-AXIS STAGE 
CONTROL ONLY.

DO NOT CHANGE CONSOLE FOCUS.
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7 – Installation, Alignment and Calibration Procedures

 Software Installation Instructions

Install on a new system

1. Place the diskette in the drive.

2. Select Start then Run from the Windows NT task bar.

3. Type the filename    a:setup

4. Click on the OK button.

5. Follow the instructions displayed on the screen.

Install on an existing system

1. Backup your data files if they are in the C:\Noran subdirectory.

2. Backup your MAXray software settings.

3. These files are:

c:\noran\wds\bin\labels.txt

c:\noran\wds\bin\scan_tab.txt

c:\noran\wds\bin\user_scn.txt

4. Place the diskette in the drive

5. Select Start then Run from the Windows NT task bar.

6. Type the filename    a:setup

7. Click on the OK button.

8. Follow the instructions displayed on the screen.

9. Copy your MAXray software settings back into their original directories.

10. Copy your backed up data back into their original directories.
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MAXray Installation

Required Tools
• Metric and SAE Hex Wrench Sets 

• 10" Crescent Wrench

• Flat and Phillips Screwdrivers

• MAXray Install/Spares Kit (700P135998)

• Oscilloscope (20 MHz)

• Analog Ratemeter

Installation Procedures
Refer to Figure 7-1.

1. Unpack the Slide Interface Assembly from the shipping container. If the Optic Support Tube 
is not installed into the Slide Interface, install it now.

Remove the Electron Trap by loosening the two M2 Screws that hold it in place. Carefully 
install the Optic Support Tube into the front of the Slide Interface (flange end), inserting the 
end of the Support Tube which has 4 tapped holes. Secure the Support Tube in the 
Spectrometer Mount Block using 4 M2 screws and lock washers. Replace the Electron Trap.

Some column designs call for a set screw to secure the X-ray Optic (XO); if required, insert the 
Set Screw into the tapped hole on the side of the Optic Support Tube. Leave clearance for 
the X-ray Optic. Do not adjust any other screws on the Slide Interface.

Figure 7-1: Slide Interface Example
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2. Attach the Port Adaptor (column specific) to the Slide Interface as shown in the Column 
Design Drawings that should be supplied. Be sure to install any o-rings that may be called out.

3. Before installing the MAXray or Slide/Interface, record the system base pressure. Be certain 
that the pressure is representative of a typical base pressure. Vent the microscope column and 
remove the port cover for the designated installation port. Mount the Slide Interface to the 
port, using supplied hardware. Do not tighten the bolts.

4. Using a flashlight looking down the Support Tube, verify the tip of the pole piece is centered in 
the tube. If it is not centered loosen the Port Adaptor screws (which mount to the chamber) 
and shift the alignment to center the pole piece in the Support Tube.

Tighten all Port Adaptor bolts, and verify the alignment of the pole piece in the Support Tube.

Figure 7-2: View Down Support Tube
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5. Viewing the inside of the chamber from a stage door or another port, insert the Slide Interface 
until the Support Tube is visible and accessible for installation of the X-ray Optic. Install the 
X-ray Optic by pushing the large end into the Support Tube. This is designed to be a snug 
fit — so be careful to not cock the optic during installation. If a Set Screw is required, tighten it 
against the X-ray Optic. 

Figure 7-3: Installing X-ray Optic

6. Viewing the specimen area through the open port, insert the optic slowly into the microscope 
chamber and locate the end of the optic, approximately 16mm from the central axis of the 
column (the actual optic surfaces start 3.8mm behind front of optic assembly). Observe if the 
X-ray Optic will hit anything when inserted into this position (BSED, SED etc.). Referring to the 
Column Design Drawing note the distance from the Front Plate of the Slide Interface to the 
linear rail carriage. Use a scale to adjust the position of the Carriage to the distance in the 
drawing. With the optic in position, verify that the X-ray Optic is not hitting any structures 
within the chamber. Tighten the split ring Stop on the Leadscrew at the position of the 
Carriage.

Figure 7-4: Installing X-ray Optic
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Figure 7-5: Initial Setting of the Front Stop

7. Install the Seal-Off Plate on rear of the Slide Interface using 4 M5 SHCS provided (See 
Figure 7-1). 

Close all other chamber ports and begin evacuating the chamber. This step is included to 
verify that there are no vacuum problems with the interface assembly prior to attaching the 
MAXray spectrometer. While the system is pumping down, unpack the MAXray Spectrometer, 
controller, and other peripheral equipment to prepare for installation. If the system vacuum 
integrity is not compromised, proceed with installing the MAXray spectrometer. Vacuum 
integrity can be verified by observing the pump-down curve. Even if the system base pressure 
is not obtained quickly, as long as the pressure continues down over time there probably are 
no leaks. If the chamber pressure hangs up at a value significantly higher than the typical base 
pressure, probably there is a leak somewhere. Check all o-ring seals, but remember that the 
Slide Interface must remain oriented to the pole piece as determined in step 4.

8. With the Spectrometer, Controller, and Host Computer unpacked, complete the system hook-
up so that motor functioning can be verified prior to installing the spectrometer. See the 
MAXray System Diagram at the end of this Chapter for all wiring and gas requirements. Place 
the MAXray Spectrometer on a table for testing. Complete the following hook-ups for test:

• Detector, Theta, and Turret motor cables from Controller to Spectrometer.

• Controller power cable.

• COM1 Serial Cable from Host Computer to Controller.

• Host Computer keyboard, VGA display and power cable.

DO NOT HOOK UP PCS CABLE NOW.

DO NOT HOOK UP GAS FLOW NOW.
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DO NOT HOOK UP VACUUM INTERLOCK NOW.

9. Turn on power to the Controller, then insert Floppy Disk with controller software.

Turn on power to the Host Computer and allow time to boot. Once the system has booted, 
start the MAXray software by clicking on the MAXray icon. The program will read configuration 
data from the Controller and then will accept user commands. 

See Troubleshooting on page 7-23.

Open the WDS Software by clicking on the MAXray Icon (Windows NT). From the Service 
menu, click Password, and then type bestWDS to access service options.

From the Service menu, click Monitor COM Port. Open the command dialog box by clicking 
Send Command (from the Service menu). 

Drag the Send Command window to a convenient location, and then type the command show 
in the dialog box.

The controller should send back configuration data (which is stored in the CRYSTAL.TXT file 
on the controller floppy disk) and display the information in the Monitor COM Port window. 
There will also be some calibration offsets listed below the configuration data, this data is 
stored in the CALIBRAT.TXT file (on the controller floppy disk). This verifies that 
communication is working between the host and controller. If any error messages are received 
see Troubleshooting in this document. 

From the Service menu, click Initialize Motors. The Initialize Motors verification displays. 
Click OK.

Three motors home in this sequence. At the high speeds used for homing the motors will 
generate some acoustic noise which is normal. If the motors fail to home see Troubleshooting. 

10. Vent the chamber and remove Seal-off Plate from rear of Slide Interface.

Retract the slide mechanism about 4 inches — or any necessary distance to easily access the 
screws to mount the spectrometer. Remove the Cover Plate from the front of the 
Spectrometer housing. Turn off power to the Controller and disconnect the three Motor 
Cables.

11. Position the MAXray onto the Slide/Interface, aligning the pins on the interface to the holes on 
the spectrometer body. Insert and tighten the M5 Screws (4) that secure the spectrometer to 
the interface. Be sure the O-ring surface is clean and seated prior to installation of the 
Spectrometer.

NOTE: Some versions of the MAXray do not have any PRESSURE RELIEF VALVES 
integrated on the interface. Therefore prior to installation of the spectrometer be sure that 
the AIR ADMIT valve is closed. Also prior to venting the CHAMBER with the spectrometer 
installed, an AUXILIARY PORT, or the STAGE DOOR must be loosened to provide 
pressure relief during venting. FAILURE TO PROVIDE ADEQUATE PRESSURE RELIEF 
WILL RESULT IN DAMAGE TO THE GAS FLOW COUNTER WINDOW.
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Figure 7-6: Mounting Spectrometer to Slide Interface

12. Evacuate the microscope chamber.

Immediately go to the Spectrometer Gas Inlet Ports and determine if any suction can be felt 
by covering both ports with a finger. If the ports are sucking air, the Gas Flow Counter Window 
may be damaged. See the Troubleshooting section of this manual.

Note the pump down curve (i.e., log the system pressure over time.)

The system should reach the 1E-5 mbar range within an hour. The MAXray Spectrometer 
shares vacuum with the microscope chamber, and thus provides additional gas load on the 
vacuum system. Some degradation in base pressure is expected. Depending on the size of 
the chamber and the pumps utilized this degradation can vary from 1/2 to 1 order of magnitude 
in total pressure.

Time Pressure Comment
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If the pressure is decreasing over time, then proceed to attach the P-10 gas supply using the 
Gas Kit provided.

13. Hook up the P-10 Gas Kit as follows (see MAXray System Diagram at the end of this chapter).

Attach the single stage regulator supplied to the Customers Two Stage regulator already in 
place on the P-10 Gas Cylinder. Use Teflon tape on all metal thread seals.

Use the 1/4” diameter Black Tubing to connect the Gas Supply to the Flow Meter. Note the 
use of Quick Disconnects similar to the Water Supply Lines on a Freedom Detector.

Set the 2nd Stage Regulator to approximately 10 PSI, and the 3rd Stage Regulator (the one 
NORAN supplied) to 3-4 PSI. Set the Flow Meter to 40 cc/min. for initial flushing.

Use the 1/8” diameter Clear Tygon Tubing to connect the Flow Meter to the Spectrometer 
Gas Port. Either port can serve as the supply side. 

The Flow Meter should be located at a position where the user can verify gas flow and note 
when the supply has been depleted. The Flow Meter should be leveled with the Circular level 
mounted to the stand.

Note: After establishing gas flow, verify that the chamber vacuum has not degraded. On 
FESEMs the INTERMEDIATE pressure should show minimal effect.

14. To adequately flush the Gas Flow Counter, P-10 gas must flow for approximately 4 hours. An 
overnight flush is preferred for setting Bias and SCA voltages, but 4 hours should be 
acceptable for beginning the alignment procedures. See page 1-17.

15. Connect the Spectrometer Motor Cables, PCS Power Cable (9-pin), and Vacuum Interlock. 
(See separate documentation for interface to specific microscope.) Apply power to the 
Controller and allow the system to boot (1 minute).

Initialize the motors from the Host Computer to verify that everything is still working. 

Wait the specified 4 hours or overnight.
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Alignment
Once the system has pumped down to user requirements, and the flow counter has 
been flushed, proceed with powering on the spectrometer (controller and host computer) 
if not already on. 

The most critical aspect of aligning the MAXray spectrometer is the ability to 
reproducibly locate a specimen at the exact same working distance. Even a standard 
block in a 1" cup can be tilted slightly — providing some variation in specimen height. By 
some means, once the alignment is started at a particular Working Distance (WD), the 
top of all other specimens must be located at the same point in space.

Hook up the oscilloscope to the AMP Out BNC on the Spectrometer body, and set the 
time base to 1usec and sensitivity to 1V/div. Offset the channel DC level so that a full 0 
to 5V waveform can be observed.

Standards will be provided for alignment and performance validation. It is not yet 
determined if the standard will remain with the customer or be returned to NORAN. The 
standard provided must be used for any sensitivity (CPS/nA) validation.

1. Start the WDS software by clicking on the MAXray Icon (Windows NT). 

2. From the Services menu, click Password, and type bestWDS.

From the Services menu, select Monitor COM Port, and open the command dialog box by 
selecting Send Command.

Move the Send Command window to a convenient location, and type the command show in 
the dialog box. The controller should send back configuration data (which is stored in the 
CRYSTAL.TXT file on the controller floppy disk) and display the information in the Monitor 
COM Port window. There will also be some calibration offsets listed below the configuration 
data, this data is stored in the CALIBRAT.TXT file, also on the controller floppy disk.

3. From the Service menu, click Initialize Motors. Verify by clicking OK.

Three motors home in this sequence. If any problems are encountered see the 
Troubleshooting section. 

4. Start with a Carbon Standard Specimen (provided). Use 10kV accelerating voltage or the 
highest available setting for the system. Adjust the probe current to 5nA or system maximum 
(whichever is less). The magnification should be at 5000X or greater. Be sure that the column 
is aligned and the beam current as steady as possible (after flashing FE source). Once the 
carbon specimen is located and in focus, the position in space of the specimen must be 
reproducible for all other specimens. “In focus” is defined as a reproducible working distance 
and focus lense settings.

5. Insert the Spectrometer to the previously set Stop (step 6 during Installation). Set the 
spectrometer to nominal values of the Bragg angle for carbon, by opening the Settings menu, 
and selecting Position Spectrometer. Choose “C” from the Periodic Table and note that 
commands are being sent to the controller (displayed in the Monitor COM Port window.)
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6. Once the motors have stopped moving, pulse waveforms should be visible on the oscilloscope 
(check triggering). If the waveforms are very low amplitide (LT. 1V) or if the pulses exceed 5V 
and clipping is observed, then the Gas Flow Proportional Counter BIAS needs to be adjusted. 

Change the Bias voltage. From the Service menu, click Electronics. 

Change the bias, baseline, and window voltage settings. Change the bias value to obtain 
pulses which utilize the full dynamic range of the PCS Amplifier. See Figure 6-7, and verify the 
values of the SCA baseline and window.

If no pulses are visible see Troubleshooting.

If you do not have an oscilloscope see Bias Scan and SCA Scan.

Figure 7-7: PCS Pulse Waveforms

7. From the Acquire menu, click Element Scan, and then choose “C” from the periodic table to 
scan the spectrometer over a range of expected peak intensity positions for Carbon.

Once a peak is observed set the spectrometer to the energy value by typing: energy 
equals.XXX, in the Send Command Window. Once the spectrometer is set at the peak 
position open the Count menu and select Ratemeter to open a ratemeter window. 
Alternatively use the Analog Ratemeter hooked-up to the “PD” BNC on the Spectrometer 
PCS Electronics.

The objective is to now align the Spectrometer and X-ray Optic to obtain maximum count rate 
at carbon. There are many degrees of freedom in performing this alignment:

• Spectrometer Tilt (points optic to established working distance)

• Spectrometer Horizontal (lateral position optic relative to specimen)

• Spectrometer Intersection (focus of optic to specimen position)
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• Diffractor Tilt (position of Turret relative to collimated beam)

• Diffractor Angle (must be at the Bragg angle for maximum intensity)

• Detector Angle (relative to the diffracted beam)

Additionally, the impact of each of these alignments is energy dependent. There are some 
interaction effects which necessitates iteration between all adjustments.

• AC. Spectrometer Tilt and Spectrometer Intersection.

• CD. Diffractor Angle and Spectrometer Intersection (especially at high energy).

Figure 7-8: Spectrometer Alignment Adjustments

Alignment is started at carbon Ka, because the x-ray optic has the largest acceptance angle 
for low energies, and the effects of misalignment are less pronounced. After alignment at CKa, 
the spectrometer is aligned to maximize count rate for AlKa, which is more difficult, and 
requires more iteration to achieve proper intensity and resolution. The alignment at AlKa will 
not adversely affect the alignment at CKa unless the optic is defective.

8. Adjust the Horizontal Adjustment screws which move the spectrometer in a horizontal plane 
(inclined, relative to beam axis).

Turn both screws simultaneously, loosening one and tightening the other (on either side of the 
interface block). You should observe a fall off in total count rate on either side of the peak 
position for the horizontal axis.
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NOTE: If the ratemeter does not appear to respond to changes even though you see higher 
repetition rates on the oscope, the SCA settings may need to be adjusted.

Figure 7-9: SCA Settings from Oscilloscope

9. Loosen the Tilt Adjustment Lockdown screws to allow the movement of the spectrometer tilt 
axis. Use the Tilt Adjustment Screw to change the tilt of the spectrometer to maximize 
countrate. DO NOT change the Minimum Tilt Stops as these should prevent the optic from 
hitting the pole piece. If the count rate only drops as the spectrometer is tilted, retract the X-ray 
optic (Intersection adjustment) about 2-3 mm and loosen the Minimum Tilt stops by 1/4 turn, 
and then try to maximize counts using the Tilt Adjustment Screw.

10. You may need to iterate between the All Three Adjustment Axis a few times, being sure you 
are at the true peak for the element being analyzed. (Repeat scans over the peak and then set 
the spectrometer to the energy (angle) for maximum intensity). Do not be concerned if the 
peak does not fall at the correct energy. Calibration offsets will be added later to correct the 
peak position relative to the energy axis. Also, the port adaptor and flange are designed to 
position the spectrometer such that minimum adjustment is required. Avoid severe changes to 
the nominal position.

If drastic changes are needed, something may not be assembled correctly.

11. Once you obtain expected intensities for carbon (3000 cps/nA at 5kV-6000 cps/nA at 10kV), 
move to the aluminum specimen on the standards block. Be sure to have the specimen at the 
exact same working distance as carbon. Use the Set Spectrometer function to position the 
spectrometer for aluminum. This will automatically change diffractor and reset electronics to 
pre-established defaults.

Perform an Element Scan to locate the peak intensity energy channel and use the Send 
Command window to position the spectrometer at that energy. Again observe the oscilloscope 
for the pulse amplitudes.
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12. Repeat the Horizontal and Tilt Adjustments to maximize count rate. The aluminum (and 
other high energy lines) count rate can be influenced greatly by the specimen to optic distance 
— the Intersection Adjustment will be more critical. Be careful, if you have changed the 
minimum tilt stops, that the X-ray optic does not hit the pole piece during any change to the 
Intersection Adjustment.

Figure 7-10: Relative Intensity Response

13. The aluminum adjustment is very sensitive (see Figure 7-10), and can be difficult. Attempt to 
obtain the best possible count rate, as this will assure alignment for all elements of interest. 
Again, be absolutely sure the spectrometer set at the peak intensity energy by scanning over 
the peak. If the peak is split (two peaks) or severely distorted, set the spectrometer to the 
energy at the midpoint between the peaks, and re-adjust all axis of the spectrometer for 
maximum counts.

14. After adjusting for maximum aluminum intensity, check alignment again at the silicon K line. 
Minor adjustment of the Tilt and Intersection is all that should be required. The same spectral 
distortions can occur at silicon, and these should be eliminated or minimized. The use of TAP 
for silicon is stretching the limits for the crystal, so some peak distortion is expected.

15. Once silicon intensity and resolution specifications are obtained, the adjustment axis must be 
locked down. The spectrometer is positioned at the SiKa peak energy (maximum counts), and 
the Ratemeter is observed while tightening the lock-down screws. The Average Maximum 
CPS must be maintained during the lock-down. Tighten Tilt Adjustment Lockdown screws to 
prohibit changing tilt. It may be necessary to alternate between Lockdown and Minimum Tilt 
screws (which counteract each other) to keep the count rate maximized. If the Intersection 
Distance was changed from the install position, re-position the Stop and tighten. The 
Horizontal adjustments should be tight already — if the opposing screws were moved simul-
taneously. Do not overtighten the lock-down screws. They should only be tightened enough to 
prevent changes in the aligned position.

16. The spectrometer should be retracted and inserted to verify that the aligned position is 
maintained after moving.



Crystal Installation 7 –  Installation, Alignment and Calibration Procedures

7-14 MAXray Service and Installation Manual

Once the spectrometer is aligned to the microscope, the calibration offsets for each crystal 
must be determined. See MAXray calibration data.

PLEASE DOCUMENT PROBLEMS IN WRITING.

Crystal Installation

Creating the IbeX/MAXray Crystal Definition File
When the IbeX / MAXray controller software starts up, it reads the CRYSTAL.TXT file on 
the controller floppy disk.

This file defines the configuration of the spectrometer. It can be edited with any ASCII 
editor such as DOS Edit.

Below is an example and a description of the individual entries in the file.

The underlined items are the ones to edit. Never use more than ONE SPACE to 
separate items.

ECS Type B ECS TYPE A for older systems, ECS TYPE B for newer 
systems.

LEFT HAND LEFT HAND or RIGHT HAND spectrometer.

6 DIFFRACTORS (1, 2, 3, 4, 5 or 6) the number of crystals on the turret.

POSITION 0 The first turret position (see Figure 7-1).

MoB4C145-B The name of this crystal.

SPACING 145.0 The 2d spacing of this crystal in Angstroms.

HOME ANGLE 240.0 The angular position of this crystal on the turret see dia-
gram.

MIN keV 0.121 The minimum energy in the range of this crystal.

MAX keV 0.395 The maximum energy in the range of this crystal.

POSITION 1 The second turret position.
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Figure 7-11: Figure 7-1: Turret Positions

Mounting the Crystals On the Turret
The crystals MUST be mounted on the turret in a special order. The crystal with the 
largest 2d spacing goes in POSITION 0 (see Figure 7-1). The crystal with the next 
largest 2d spacing goes in POSITION 1. On the IbeX, if two or more crystals have the 
same 2d spacing, the crystal that is curved for the lower atomic number element is 
mounted before the others, then the crystal curved for the next highest atomic number is 
mounted.

Calculating the Minimum and Maximum keV
These values depend on the 2d spacing of the crystal and the angular range of the 
spectrometer.

IbeX MIN keV = 12.398 / (2d x 0.7071) [IbeX MAX angle = 45°] sin  =sin 
45=0.7071

IbeX MAX keV = 12.398 / (2d x 0.2164) IbeX MAX angle = 12.5°
MAXray MIN keV = 12.398 / (2d x 0.9385) MAX angle = 68.5° sin63.5 = 0.9304

MAXray MAX keV = 12.398 / (2d x 0.2419) MIN angle = 14° sin 14° = 0.2419
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For example:

If the 2d spacing of the crystal is 145.0 Angstroms:

IbeX MIN keV = 12.398 / (145.0 x 0.7071) = 12.398 / (102.529) = 0.121

IbeX MAX keV = 12.398 / (145.0 x 0.2164) = 12.398 / (31.378) = 0.395

Crystal Names
The crystal names can be a combination of the crystalline material, the 2d spacing, and 
the element for which they were curved. If the crystal is made from a natural material 
(LiF, PET, TAP), the 2d spacing is omitted from the name. If the crystal is made from 
synthetic material (MoB4C, NiC, WSi, CrSc), the 2d spacing is included in the name. If 
the crystal is curved for a specific element (always on the IbeX, never on the MAXray), 
the atomic symbol is added at the end of the name preceded by a dash. No distinction is 
made between K, L or M lines.

For an IbeX MoB4C crystal with a 2d spacing of 145.0 Angstroms that is curved for 
Boron, the name is:   MoB4C145-B

The same crystal used on a MAXray will have the name:   MoB4C145

Special Case: LiF
A Lithium Fluoride (LiF) crystal can come in more than one type;
LiF(200) with a 2d spacing of 4.027 Angstroms, and
LiF(220) with a 2d spacing of 2.848 Angstroms.

A LiF crystal of the 200 variety with a 2d spacing of 4.027 Angstroms and curved for Iron 
has the name:   LiF(200)-Fe

IbeX
MIN KeV

IbeX
MAX KeV

MAXray 
MIN KeV

MAXray 
MAX KeV

Default 2d Space 
Turret Position

Calibration 
Sample

LiF(220) 6.156 20.117 4.679 17.996

LiF(200) 4.354 14.227 3.309 1 2.727

PET 2.006 6.554 1.524 5.863

TAP 0.681 2.225 0.517 1.990 25.75 5 AL/SC

WSi60 0.292 0.955 0.222 0.854 60 4 O2

NiC80 0.219 0.716 0.167 0.641 80 3 N

NiC100 0.175 0.573 0.133 0.513 100 2 C

 
MoB4C145

0.121 0.395 0.0919 0.353 145 1 B

MoB4C200 0.0877 0.286 0.0666 0.256 200 0 Be



7 –  Installation, Alignment and Calibration Procedures Crystal Installation

MAXray Service and Installation Manual 7-17

A LiF crystal of the 220 variety with a 2d spacing of 2.848 Angstroms and curved for 
Strontium has the name:   LiF(220)-Sr

Notes
• These instructions refer to the IbeX controller software version 2.01 and higher.

• These instruction refer to all versions of the MAXray controller software.

• Most IbeX spectrometers are LEFT Handed.

• All MAXray spectrometers are LEFT handed.

• The crystal 2d spacing can be found on the crystal storage box.

• For the PeakCAP software only, the crystal names in this file must match those 
in the PeakCAP database.

• Be careful not to type a zero instead of an O for Oxygen.

• A dash is the same character as a minus sign.

• Please note that the MAXray turret positions begin with ONE, not ZERO.

Example of a CRYSTAL.TXT File for a Six-Crystal MAXray Spectrometer
This text file is created automatically using the save calibration data from the host PC.

BEAM METER YES
ECS TYPE B
LEFT HAND
6 DIFFRACTORS

POSITION 0
MoB4C145-B
SPACING 145
HOME ANGLE 240

POSITION 1
NiC100-C
SPACING 100
HOME ANGLE 180

POSITION 2
WSi60-N
SPACING 59.8
HOME ANGLE 120
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POSITION 3
WSi60-O
SPACING 59.8
HOME ANGLE 60

POSITION 4
TAP-Al
SPACING 25.75
HOME ANGLE 0

POSITION 5
PET-Mo
SPACING 8.742
HOME ANGLE 300
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MAXray Calibration Procedure

Turret Scan
Each of the six diffractors on the turret are mechanically aligned as closely as possible 
after installation. Because there are small offsets that cannot be corrected for using 
screws, the turret must be rotated over a small angular range while intensities are 
measured at discrete positions. If the spectrometer is centered as closely as possible to 
an x-ray peak, this turret scan generates a peak of intensities and computes the center 
of the peak. The offsets should be small (less than 5 degrees) and very close to each 
other (less than 3 degrees). If these differences are much larger, there is a problem. The 
home position of each diffractor is stored on the controller floppy disk in the file named 
CRYSTAL.TXT. (refer to page 7-1 through 7-4 to edit this file.) You will need to edit some 
values in this file for the turret calibration. This procedure should be performed AFTER 
the initial spectrometer alignment on carbon and BEFORE the final spectrometer 
alignment on Silicon.

Begin the procedure by placing the carbon sample in the beam and use the Acquire/
Element Scan function perform a scan over the carbon K alpha peak. Although it is 
supposed to be at 0.282 keV, the spectrometer has not yet been aligned and the peak 
may be several eV away from this energy in either direction. When the scan is complete 
and the peak has been located, use the energy equals command from the Send 
Command window to move the spectrometer to the energy of the peak center which is 
the energy with the maximum number of counts. When the spectrometer has stopped, 
use the Service/Turret Scan function to perform the turret scan. When the scan is 
complete a peak centroid will be computed and displayed over the turret scan plot. Apply 
this initial turret offset value to ALL diffractors by editing the HOME entry in the 
CRYSTAL.TXT file. After the Carbon alignment has been completed, perform this turret 
scan for one x-ray line using each of the six diffractors. Use the table below to record 
your measurements. When complete, edit the CRYSTAL.TXT file using the Windows/
Notepad program so that the crystal home positions match the angles found during the 
calibration. It is necessary to reboot the controller after editing this file. Retest the 
carbon sample again to check the success of the turret calibration.

Diffractor Name Original Home Angle Calibrated Home Angle

1

2

3

4

5

6
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Peak Offsets
In the next calibration step, angular offsets will be added to the controller file named 
CALIBRAT.TXT so it is important that the controller has been booted from a floppy disk 
that contains no CALIBRAT.TXT file. Look for this disk using Windows/Notepad. This 
procedure should be performed AFTER the spectrometer alignment.

Starting again with carbon, scan over the K-alpha peak, find the peak position using 
View/Peak Information, and record this peak position. If the peak is not at the correct 
energy (0.282 keV) and angular offset must be added to shift the peak. The offset for the 
crystal motor and the detector motor should be the same. An approximate offset can be 
calculated, or an offset tried and then tested. Below is an example calculation for a 
Carbon peak calibration using the Bragg equation to find the difference between the two 
peak positions in degrees. The supplied program WdsCalc should be used to calculate 
the angels based on the energy offsets.

Since

Re-arrange

Where  The angle in degrees

 The wavelength in Angstroms 

 The spacing of the diffractor in Angstroms

Example: The crystal used was a NiC100 that has a 2d spacing of 100 Angstroms.

1. Peak position from the initial scan over carbon K-alpha = 0.262 keV

2. Wavelength = (12.398 / 0.262) =47.3206 Angstroms

3. Angle = Asin(47.3206 / 100) =28.2426 degrees

4. Correct peak position of the carbon peak =0.282 keV

5. Wavelength = (12.398 / 0.282) =43.9645 Angstroms

6. Angle = asin(43.9645 / 100) =26.0812 degrees

7. The angular offset = 28.2426 – 26.0812 = 2.1614 degrees

Because the starting peak position was lower in energy than the final peak position, the 
offsets must be ADDED.

Use the CRYSTAL x POINT SET command in the Service/Send Command window to 
set the new offsets and scan over the Carbon K-alpha peak again.

If the NiC100 diffractor is in the THIRD position on the turret, the command would be:

crystal 2 point set 26.0812 � 2.1624 � 2.1624

λ 2d θsin=

θ a λ 2d( )⁄( )sin=

θ =

λ =

2d =
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If the peak is within 1.0 eV (0.001 keV) of the correct position, the calibration for this 
crystal is complete. The controller software recognizes the diffractors arranged on the 
turret in positions Zero through Five. In the Settings / Configuration window the 
diffractors are listed in the order One through Six. Use the save calibration data 
command to write the offsets to disk.

Detector Bias Voltage, SCA Baseline, and Window Voltages
It is important to determine the correct detector bias voltage, and the correct SCA 
baseline and window voltages for each x-ray line on the flow proportional counter. The 
controller shipped from the factory may not have the correct settings installed on the 
controller diskette. These voltages should be verified using the Settings/SCA Scan 
function. The bias should be high enough to pull the signal peak out of the noise and 
center it at between 3.0 to 3.5 volts. The SCA baseline voltage should be set at the 
valley between the noise peak and the signal peak and the SCA window voltage should 
be set to be as wide as the signal peak. There are entries in the window program’s 
initialization file that can be used to set these voltages based on low and high energy 
measurements and the slope and intercept of their associated plots.

Calibration Tips

1. Delete any CALIBRAT.TXT file from the controller disk before starting.

2. Remove the calibration offsets for any crystal before beginning, and remember to replace 
them when complete.

3. If re-calibrating an element on a diffractor that has already been calibrated, first set the crystal 
and detector offsets to zero for this diffractor.

4. If the calculated angular offset does not work, use small offsets to find the closest.10

5. The offsets for one diffractor should be similar the all others and should be less then ±3.0 
degrees.

6. If the calibration is more than 3.0 degrees off, verify that the correct sample is being used.

List of Commands
These commands can be sent using the Service/Send Command window.

1. Set a calibration offset point.

crystal X point set aa.aaaa  b.bbbb  c.cccc

where: X is the turret position of the crystal (0 through 5)

aa.aaaa is the Bragg angle of the peak

b.bbbb is the crystal motor offset

c.cccc is the detector motor offset

NOTE: Always use four digits after the decimal point.
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2. Remove a calibration offset point.

crystal X point remove aa.aaaa

where: X is the turret position of the crystal (0 through 5)

aa.aaaa is the Bragg angle of the peak

NOTE: Always use four digits after the decimal point

3. Save the calibration offsets to the controller floppy disk.

save calibration data

4. Display the Turret and Calibration information in the Monitor window.

show

5. List the system status in the Monitor window.

status

6. Move the spectrometer to an energy position.

energy = aa.xxx

where: aa.aaa is the desired energy in keV

NOTE: The energy selected must be in the range of the active crystal.
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Troubleshooting
This guide is intended to outline all potential problems which may be encountered in the 
field. Some of the root causes of failure should not occur in the field (like feed through 
wiring error), however all possible sources of failure are listed for completeness.

Motor(s) Fails to Move When Commanded to Home

1. Feed through wiring error.

2. Internal motor harness error or damage. See Wiring and Plumbing drawing.

3. Motor cables not hooked up correctly. See the MAXray System diagram.

4. Controller power supply problems.

5. Microstep motor board problems.

6. Bad Motor. Replace motor. See Motor Replacement Instructions drawing.

Motors Move, But Fail to Home as Specified

1. Motor cables not hooked up properly. See the Alignment Flow Chart.

2. Motor binds prior to reaching lower limit. Call Factory 

3. Bad lower limit or home sensor (microswitch or optical). Replace Sensor. See the Wiring and 
Plumbing drawing.

4. Damaged wiring to sensors. See the Wiring and Plumbing drawing.

5. Microstep motor board problems.

Motors Home as Specified, but Error Occurs at Extreme Positions

1. Mechanism reaches limit sensor prior to reaching specified angle.

Turret Home Angle is Not 90 Degrees to the Baseplate as Specified
This could occur in the field after a change in diffractor. A precision 90 degree gauge 
block will be required to align the turret.

1. Loosen the Sensor Mount Clamp Screws and adjust the Optical Sensor Mount using the 
Adjust Set Screws as shown in the diagram below. This moves the sensor position relative to 
the Flag on the Turret, and moves the Home position. Caution, this adjustment is very 
sensitive. The Microstep motor boards seek home by looking for both the optical sensor 
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interrupt AND the next index pulse from the optical encoder. Therefore, with 100:1 gear 
reduction on the Turret motor, very small angular change in the Flag position may be all that is 
needed. When the proper alignment is achieved, tighten the Clamp Screws.

Figure 7-12: Optical Sensor Mount Adjustment

Motor Movement is Noisy

1. Excessive play in worm-gear/worm-wheel mesh. Adjust for minimal play.

2. Poor lubrication of gearing or bearings. Use Fomblin or Krytox vacuum compatible grease on 
all gears and bearing as required. Use sparingly, however it is found that the worm 
mechanisms can require a generous application to get lubricant into all teeth. Wipe away 
excess grease from any mechanisms.

DO NOT LUBRICATE HARMONIC DRIVE IN TURRET MECHANISM. Consult factory if this 
mechanism is creating excess noise.

3. Motor is bad. Replace motor.

No Counts Detected

1. Wrong standard chosen for spectrometer setting.

2. Diffractors not labeled correctly. Check CRYSTAL. TXT File. Change to other diffractors which 
could detect same energy (even if not optimum).

3. No HV Bias on flow counter. Check interlock.

4. Not sufficient bias on flow counter. Use Electronics Dialog box to adjust bias.

5. SCA not set up properly. Use Electronics Dialog box to adjust SCA settings.

6. Gross misalignment. Return to factory settings. Align on carbon.

7. Gross calibration error in spectrometer. Remove Set Points and use wide scan to find peaks.
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Poor Intensity (CPS/nA) — Not Meeting Specifications

1. Poor alignment. Re-adjust all spectrometer setting at a fixed stage position.

2. Optimize bias and SCA setting. Use o-scope to observe waveforms.

3. Bad diffractor (crystal or synthetic).

4. Turret angle is off. Perform turret scan and adjust home position in CRYSTAL.TXT file.

5. Specifications can only be checked using NORAN-supplied standard specimens.

6. For poor light elements (fluorine and lower), proportional counter window can affect intensities. 
Change window.

7. Electron column conditions as specified (accelerating voltage, aperture setting).

8. Intensities OK at low energy, poor at high energies. Optic is not pointing at the specimen. 
Realign spectrometer.

Intensities OK, Resolution, P/B Poor

1. Co-alignment of optic is bad. Check to see if optic is damaged.

2. SCA not properly set. Check baseline setting (>.2V)

3. Theta-Detector scan synchronization off - Perform Detector and Theta Scan independently 
and apply calibration offsets.

Detector and Diffractor Motor Calibration

Setting up the Calibration

1. Load the sample into the microscope.

• Whenever possible, use a pure element standard.

• For elements such as nitrogen and oxygen, use a binary compound when possible.

2. Set the microscope’s Accelerating Voltage and Beam Current.

• For all synthetic diffractors (light elements), use 10 keV and 5 nAmps.

• For TAP and PET diffractors (heavy elements), use 20 keV and 5 nAmps.

• For LiF diffractors, use 30 keV and 5 nAmps.

3. Run the MAXray software.

Double-click on the program icon.

4. Record the crystal name.

From the Settings menu, click Configuration.

Determine the diffractor 2d spacing. 

Record the diffractor 2d spacing, the element name, and the x-ray line.
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From the Edit menu, click Scan Parameters. 

Read the theoretical peak energy of the x-ray line.

Record the theoretical peak energy, the sample used, the accelerating voltage, and the 
beam current.

5. Set the Bias, Baseline, and Window.

From the Edit menu, click Scan Parameters. Use the following parameters.

Save the settings by clicking Save.

6. Move the diffractor and detector to their initial positions.

From the Settings menu, click Position Spectrometer.

Select an element from the periodic table, and then click OK.

7. Unlock the service menu.

From the Service menu, click Password. Enter the password “bestWDS.”

8. Display the controller command window.

From the Service menu, click Send Command.

Type show. No offsets should appear.

If there are offsets, remove them with the command “crystal (n) point remove (bragg).”

Example: If an offset exists for crystal 0 at a bragg angle of 23.1731, the command is “crystal 
0 point remove 23.1731"

9. Display the COM Port Monitor window.

From the Service menu, click Monitor COM Port.

Calibration Procedure

1. From the Service menu, click Diffractor Scan.

2. Record the scan parameters.

Scan over a wide diffractor range around the theoretical peak energy.

Typical scan parameters are:

• plus/minus 0.200 KeV (for some diffractors this range maybe too wide. Use a smaller range 
when necessary)

Parameter Heavy elements Light elements 

Bias 2250 volts 2200 volts

Baseline  1.5 volts  0.3 volts

Window  6.5 Volts 8.0 volts
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• a step of 4 eV

• a dwell of 1 second

3. Record the energy and counts in the peak.

Watch the Monitor COM Window as the data is sent back from the controller.

Locate the largest energy peak.

4. Record the scan parameters.

Scan over a narrow diffractor range, around the recorded peak energy.

Typical scan parameters are:

• plus/minus 0.010 KeV

• a step of 1 eV

• a dwell of 1 second

5. Record this final diffractor position and the counts in the peak.

Watch the Monitor COM Window as the data is sent back from the controller.

Locate the largest energy peak. 

6. Position the detector correctly for the diffractor scan.
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Scan from 0.010 keV before and to 0.001 keV past this energy. Use a step of 1 eV and a dwell 
of 1 second.

Close the Crystal Scan window.

7. From the Service menu, click Detector Scan.

8. Record the scan parameters.

Scan over a wide detector range around the theoretical peak energy.

Typical scan parameters are:

• plus/minus 0.200 keV

• a step of 4 eV

• a dwell of 1 second

9. Record this energy and the counts in the peak.

Watch the Monitor COM Window as the data is sent back from the controller.

Locate the largest energy peak.

10. Record the scan parameters.

Scan over a narrow detector range around the recorded peak energy.

Typical scan parameters are:

• plus/minus 0.010 keV

• a step of 1 eV

• a dwell of 1 second

11. Record this final detector position and the counts in the peak.

Watch the Monitor COM Window as the data is sent back from the controller.
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Locate the largest energy peak.

12. Position the detector correctly for the diffractor scan.

Scan from 0.010 keV before and to 0.001 keV past this energy. Use a step of 1 eV and a dwell 
of 1 second.

Close the Detector Scan window.

13. Repeat steps 1 through 12.

14. Calculate and record the crystal and detector offset.

Run the WDS Calculator program (c:\noran\wds\bin\calc.exe).

Enter the Crystal values for Crystal 2d Spacing, Theoretical Peak Energy, and Measured Peak 
Energy (final diffractor). Click Compute the Calibration Offset, and then record the crystal 
offset. This value may be negative.
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Enter the detector values for Crystal 2d spacing, Theoretical Peak Energy, and Measured 
Peak Energy. Click Compute the Calibration Offset, and then record the detector offset. This 
value may be negative.

15. Send the calibration data to the controller.

From the Service menu, click Send Command.

Example: CYSTAL 0 POINT SET 23.1731 0.3702-0.0881

In this example, a diffractor offset of 0.3702 degrees and a detector offset of -0.0881 degrees 
are used with a bragg angle of 23.1731 degrees for the first calibration value of diffractor 0.

NOTE: Use only one space between words and numbers.

NOTE: Always use exactly four decimal places for bragg angles, diffractor 
offsets, and detector offsets.

16. Check the beam current and re-adjust it if necessary.

17. Record the scan parameters.

Setup over a wide energy scan, around the theoretical peak energy.

From the Acquire menu, click Scan Setup.

Typical scan parameters are:

• plus/minus 0.100 keV

• a step of 3 eV

• a dwell of 1 second

18. Begin the scan.

From the Acquire menu, click Start Scan. 

19. Record the peak energy value.

First, move the cursor to the peaks center. 
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Second, From the View menu, click Peak Information. The peak energy value displays.

20. Record the calibration offset.

Run the WDS Calculator program (c:\noran\wds\bin\calc.exe).

Based on the peak position enter the Crystal 2d Spacing, Theoretical Peak Energy, and 
Measured Peak Energy. 

21. Compute and record the final crystal offset.

Add the calibration offset to the original crystal offset.

22. Compute and record the final detector offset.

Add the final crystal offset to the original Detector offset.

23. Remove the original offsets.

From the Service menu, click Send Command.

Example: CRYSTAL 0 POINT REMOVE 23.1731

In this example, the offsets for the angle 23.1731 degrees were removed from the first crystal 
at position 0.

24. Set the final calibration point.

From the Service menu, click Send Command.

Example: CRYSTAL 0 POINT SET 23.1731 0.0513 0.1562

In this example, a crystal offset of 0.0513 degrees and a detector offset of 0.1562 degrees will 
be used for an angle of 23.1731 degrees for the first crystal at position 0.

NOTE: Use only one space between words and numbers.

NOTE: Always use four decimal places; no more; no less.

25. Write the calibration data to the controller disk.

From the Service menu, click Send Command.

Example: SAVE CALIBRATION DATA

Note: Make sure the floppy disk is inserted into the controller and not write 
protected.

26. Record these scan parameters.

Setup a narrow energy scan, around the theoretical peak energy.

From the Acquire menu, click Scan Setup.
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Typical scan parameters are:

• plus/minus 0.025 keV

• a step of 1 eV

• a dwell of 1 second

27. Begin the scan.

From the Acquire menu, click Start Scan.

28. Record the peak energy value.

First, move the cursor to the peaks center. 

Second, from the View menu, click Peak Information. The peak energy value displays.

Bias Scan
Determine the detectors bias voltage for an x-ray line.

1. From the Settings menu, click Bias Scan. 

2. Begin the Scan.

Use the systems default settings. Click Start.

3. Center the correct bias voltage.

Correct Bias 
Voltage
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The correct bias voltage is above the first shoulder, and prior to the sharp peak. If this point is 
not visible or not centered on the display modify the starting voltage until the correct voltage is 
determined. the example above shows a centered voltage point.

• If the display is to far left − increase the starting bias and decrease the ending bias by the 
same amounts.

• If the display is to far right − decrease the starting bias and increase the ending bias by the 
same amount.

4. Exit Bias Scan.

Click Close.

SCA Scan
A single channel analyzer (SCA) scan fine tunes the detector bias voltage (found with 
the Bias Scan function). The Detector Bias voltage, SCA Baseline voltage, and SCA 
Window voltage must be determined.

1. From the Settings menu, click SCA Scan.

2. Begin the scan.

Enter the Bias voltage and Low Level Discriminator (LLD), and then click Start.

• LLD − The voltage setting that prevents the noise peak from displaying.

• Bias − The voltage determined during in the bias scan.

• Use the system default settings for all other parameters.

3. Determine the correct SCA voltage.

• The SCA voltage occurs at the valley between the noise peak and the signal peak.

• The SCA Window voltage is the peaks width, from the baseline voltage to where the peak 
tails off.

4. Exit Single Channel Analyzer Scan.

Noise Peak
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Click Close.

Scan Parameters

1. Set acquisition parameters for individual elements.

From the Edit menu, click Scan Parameters.

2. Select an element.

Click the up and down arrows in the top left corner of the dialog box to select an element. Or 
click Table to select from a periodic table of elements.

3. Select the X-ray lines.

Click the X-ray Line drop down box to select the K, L, M, and N lines of interest.

4. Select a diffractor.

Diffractor settings are passed to the Scan Setup Window. The diffractor options may vary from 
spectrometer to spectrometer.

5. Enter the elements scan parameters.

• Beginning Energy − The scan’s minimum energy level, in keV.

• Ending Energy − The scan’s maximum energy level, in keV.

• Step Size − The spectrometer step size during acquisition, in eV.

• Dwell Time − The dwell time on each step, in seconds.

• Detector Bias − The optimum detector voltage for the scan range.

• SCA Baseline − The optimum detector baseline voltage for the SCA scan. By optimizing this value, 
you can reject counts produced by noise.

• SCA Window − The optimum range of detection for the SCA scan, in volts. By optimizing this value, 
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you can reject counts produced by noise. The sum of SCA Baseline and SCA Window must not exceed 

8.4V.

6. Save the defined parameters.

• To save the set of parameters click Save. Click Yes to confirm the save command.

• To reset to the systems default settings click Reset All. The bias settings and the element 
table are reset. Click Yes to confirm the reset all command.

• To reset the current element only click Reset Be (Beryllium). This buttons name changes 
each time the current element changes and only resets the current element.

7. Apply the changes to Scan Parameters.

Click Close.

Beam Current
An accurate beam current must be obtained for Quant Analysis. Current varies for many 
reason’s. The beam current reading is constantly updated while running. 

Note: Not all systems have the optional equipment necessary to perform this 
procedure.

1. From the Settings menu, click Beam Current.

2. Select a reading location.

The beam current reading is obtains from the Specimen or Beam.

• Specimen − Reads at the stage level.

• Beam − Reads at the beam device level.

3. Start the beam current reading.

Click Start. The beam current displays and continuously updates. To average the reading click 
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Damp.

4. Stop the reading.

5. Click Stop.

Setting Up Beam Current Meter
The  Beam Current Meter is connected to the special serial port board of the MAXray or 
MAXray-II Controller.  It is setup internally as COM Port 4 and although it does not use 
any interrupts, the serial port card can be configured for either IRQ 5 or IRQ 9. The 
Beam Current Meter is attached to the WDS Controller using a 9 pin male to 9 pin 
female serial cable.  A null-modem cable is not necessary and will not work.

1. To use the Beam Current Meter:

a. An RS–232 board must be installed and setup for COM4, IRQ5 or IRQ9.

b. The METER.TXT file must be on the Controller boot disk.

3. The new Beam Current Meter commands that can be used in the Send Command are:

READ BEAM ONE
READ BEAM TWO
FAR CUP IN
FAR CUP OUT

4. To use the Beam Current Meter, the first line in the CRYSTAL.TXT file must be:

BEAM METER YES

5. The new METER.TXT file must include the parameters for channel one sense, channel two 
sense, Faraday cup polarity and Faraday cup retraction delay time. Below are the acceptable 
values for each of these parameters.

channel one sense 1 or —1
channel 2 sense 1 or —l
Faraday cup polarity0 or 1
Faraday cup retraction delay time0, 1, 2, 4, 5 or 10 milliseconds

A sample file looks like that below:

CH1SENSE -1
CH2SENSE 1
FCUPPOL 0
FCUPDELAY 2
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6. To select the number of columns displayed, edit the AUTOEXEC.BAT file on the Controller 
boot disk to include one of the lines listed below. If none of these lines are found, the default of 
60 rows is used.

SET VIDEO25
SET VIDEO3O
SET VIDEO43
SET VIDEO6O

7. On boot-up, the Controller loads the beam current parameters from the CRYSTAL.TXT file and 
test the beam current meter. The results of the test can be seen on a monitor attached to the 
Controller’s VGA port.
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Calibration Records
Use these pages for each crystal.

Detector and Diffractor Motor Calibration
Diffractor name __________
Diffractor 2d spacing __________ Angstroms
Element and X-ray line used __________
Theoretical peak energy of the x-ray line__________ keV
Sample used __________
Accelerating voltage __________ keV
Beam current __________ nAmps

First diffractor scan First detector scan
Start __________ keV Start __________ keV
End __________ keV Peak __________ keV __________ Counts
Step __________ eV Step __________ eV
Dwell __________ sec Dwell __________ sec
Peak __________ keV__________ Counts Peak __________ keV __________ Counts

Second diffractor scan Second detector scan
Start __________ keV Start __________ keV
End __________ keV End __________ keV
Step __________ eV Step __________ eV
Dwell __________ sec Dwell __________ sec
Peak __________ keV __________ Counts Peak __________ keV __________ Counts

Crystal motor offset computed
Theoretical ___________ degrees
Measured ___________ degrees
Computed ___________ degree offset

Detector motor offset computed
Theoretical ___________ degrees
Measured ___________ degrees
Computed ___________ degree offset

Energy scan
Beginning Energy__________ keV
Ending Energy __________ keV
Step Size __________ eV
Dwell Time __________ sec
Detector Bias __________ volts
SCA Baseline __________ volts
SCA Window __________ volts
Crystal Name __________
Peak __________ keV __________ Counts

Detector Bias Voltage Calibration
Detector Bias Voltage__________ Volts

Single Channel Analyzer (SCA) Voltage Calibration
SCA Baseline Voltage__________ Volts 
SCA Window Voltage__________ Volts 
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Detector and Diffractor Motor Calibration
Diffractor name __________
Diffractor 2d spacing __________ Angstroms
Element and x-ray
line used __________
Theoretical peak energy
of the x-ray line __________ keV
Sample used __________
Accelerating voltage __________ keV
Beam current __________ nAmps

First diffractor scan First detector scan
Start __________ keV Start __________ keV
End __________ keV Peak __________ keV __________ Counts
Step __________ eV Step __________ eV
Dwell __________ sec Dwell __________ sec
Peak __________ keV__________ Counts Peak __________ keV __________ Counts

Second diffractor scan Second detector scan
Start __________ keV Start __________ keV
End __________ keV End __________ keV
Step __________ eV Step __________ eV
Dwell __________ sec Dwell __________ sec
Peak __________ keV __________ Counts Peak __________ keV __________ Counts

Crystal motor offset computed
Theoretical ___________ degrees
Measured ___________ degrees
Computed ___________ degree offset

Detector motor offset computed
Theoretical ___________ degrees
Measured ___________ degrees
Computed ___________ degree offset

Energy scan
Beginning Energy__________ keV
Ending Energy __________ keV
Step Size __________ eV
Dwell Time __________ sec
Detector Bias __________ volts
SCA Baseline __________ volts
SCA Window __________ volts
Crystal Name __________
Peak __________ keV __________ Counts
Detector Bias Voltage Calibration
Detector Bias Voltage__________ Volts
Single Channel Analyzer (SCA) Voltage Calibration
SCA Baseline Voltage__________ Volts 
SCA Window Voltage__________ Volts 
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Detector and Diffractor Motor Calibration
Diffractor name __________
Diffractor 2d spacing __________ Angstroms
Element and X-ray line used __________
Theoretical peak energy of the x-ray line__________ keV
Sample used __________
Accelerating voltage __________ keV
Beam current __________ nAmps

First diffractor scan First detector scan
Start __________ keV Start __________ keV
End __________ keV Peak __________ keV __________ Counts
Step __________ eV Step __________ eV
Dwell __________ sec Dwell __________ sec
Peak __________ keV__________ Counts Peak __________ keV __________ Counts

Second diffractor scan Second detector scan
Start __________ keV Start __________ keV
End __________ keV End __________ keV
Step __________ eV Step __________ eV
Dwell __________ sec Dwell __________ sec
Peak __________ keV __________ Counts Peak __________ keV __________ Counts

Crystal motor offset computed
Theoretical ___________ degrees
Measured ___________ degrees
Computed ___________ degree offset

Detector motor offset computed
Theoretical ___________ degrees
Measured ___________ degrees
Computed ___________ degree offset

Energy scan
Beginning Energy__________ keV
Ending Energy __________ keV
Step Size __________ eV
Dwell Time __________ sec
Detector Bias __________ volts
SCA Baseline __________ volts
SCA Window __________ volts
Crystal Name __________
Peak __________ keV __________ Counts

Detector Bias Voltage Calibration
Detector Bias Voltage__________ Volts

Single Channel Analyzer (SCA) Voltage Calibration
SCA Baseline Voltage__________ Volts 
SCA Window Voltage__________ Volts 
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Detector and Diffractor Motor Calibration
Diffractor name __________
Diffractor 2d spacing __________ Angstroms
Element and x-ray
line used __________
Theoretical peak energy
of the x-ray line __________ keV
Sample used __________
Accelerating voltage __________ keV
Beam current __________ nAmps

First diffractor scan First detector scan
Start __________ keV Start __________ keV
End __________ keV Peak __________ keV __________ Counts
Step __________ eV Step __________ eV
Dwell __________ sec Dwell __________ sec
Peak __________ keV__________ Counts Peak __________ keV __________ Counts

Second diffractor scan Second detector scan
Start __________ keV Start __________ keV
End __________ keV End __________ keV
Step __________ eV Step __________ eV
Dwell __________ sec Dwell __________ sec
Peak __________ keV __________ Counts Peak __________ keV __________ Counts

Crystal motor offset computed
Theoretical ___________ degrees
Measured ___________ degrees
Computed ___________ degree offset

Detector motor offset computed
Theoretical ___________ degrees
Measured ___________ degrees
Computed ___________ degree offset

Energy scan
Beginning Energy__________ keV
Ending Energy __________ keV
Step Size __________ eV
Dwell Time __________ sec
Detector Bias __________ volts
SCA Baseline __________ volts
SCA Window __________ volts
Crystal Name __________
Peak __________ keV __________ Counts
Detector Bias Voltage Calibration
Detector Bias Voltage__________ Volts
Single Channel Analyzer (SCA) Voltage Calibration
SCA Baseline Voltage__________ Volts 
SCA Window Voltage__________ Volts 
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Detector and Diffractor Motor Calibration
Diffractor name __________
Diffractor 2d spacing __________ Angstroms
Element and X-ray line used __________
Theoretical peak energy of the x-ray line__________ keV
Sample used __________
Accelerating voltage __________ keV
Beam current __________ nAmps

First diffractor scan First detector scan
Start __________ keV Start __________ keV
End __________ keV Peak __________ keV __________ Counts
Step __________ eV Step __________ eV
Dwell __________ sec Dwell __________ sec
Peak __________ keV__________ Counts Peak __________ keV __________ Counts

Second diffractor scan Second detector scan
Start __________ keV Start __________ keV
End __________ keV End __________ keV
Step __________ eV Step __________ eV
Dwell __________ sec Dwell __________ sec
Peak __________ keV __________ Counts Peak __________ keV __________ Counts

Crystal motor offset computed
Theoretical ___________ degrees
Measured ___________ degrees
Computed ___________ degree offset

Detector motor offset computed
Theoretical ___________ degrees
Measured ___________ degrees
Computed ___________ degree offset

Energy scan
Beginning Energy__________ keV
Ending Energy __________ keV
Step Size __________ eV
Dwell Time __________ sec
Detector Bias __________ volts
SCA Baseline __________ volts
SCA Window __________ volts
Crystal Name __________
Peak __________ keV __________ Counts

Detector Bias Voltage Calibration
Detector Bias Voltage__________ Volts

Single Channel Analyzer (SCA) Voltage Calibration
SCA Baseline Voltage__________ Volts 
SCA Window Voltage__________ Volts 
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Detector and Diffractor Motor Calibration
Diffractor name __________
Diffractor 2d spacing __________ Angstroms
Element and x-ray
line used __________
Theoretical peak energy
of the x-ray line __________ keV
Sample used __________
Accelerating voltage __________ keV
Beam current __________ nAmps

First diffractor scan First detector scan
Start __________ keV Start __________ keV
End __________ keV Peak __________ keV __________ Counts
Step __________ eV Step __________ eV
Dwell __________ sec Dwell __________ sec
Peak __________ keV__________ Counts Peak __________ keV __________ Counts

Second diffractor scan Second detector scan
Start __________ keV Start __________ keV
End __________ keV End __________ keV
Step __________ eV Step __________ eV
Dwell __________ sec Dwell __________ sec
Peak __________ keV __________ Counts Peak __________ keV __________ Counts

Crystal motor offset computed
Theoretical ___________ degrees
Measured ___________ degrees
Computed ___________ degree offset

Detector motor offset computed
Theoretical ___________ degrees
Measured ___________ degrees
Computed ___________ degree offset

Energy scan
Beginning Energy__________ keV
Ending Energy __________ keV
Step Size __________ eV
Dwell Time __________ sec
Detector Bias __________ volts
SCA Baseline __________ volts
SCA Window __________ volts
Crystal Name __________
Peak __________ keV __________ Counts
Detector Bias Voltage Calibration
Detector Bias Voltage__________ Volts
Single Channel Analyzer (SCA) Voltage Calibration
SCA Baseline Voltage__________ Volts 
SCA Window Voltage__________ Volts 



Calibration Records 7 –  Installation, Alignment and Calibration Procedures

7-44 MAXray Service and Installation Manual



MAXray Service and Installation Manual 7-45

MAXray System
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Alignment Procedure Flow Chart

Load Standard 
Specimen. Use typical 
sample holder for 
Customer.

Set SEM to 10kV or 
MAX for instrument. 
1nA or highter if 
possible. 5000X on 
Carbon Speciment.

Set Specimen at 15mm 
W.D. Fix Focus Control 
at Repeatable Settings. 
MAXray at Designed 
Instersection Distance.

Obtain an Element 
Scan at C Ka Using 
Exiting Calibration 
Points.

Position Spectrometer 
at Peak Centroid 
Energy (Send 
Command: “energy 
equals.xxx”)

Obtain a Turret Scan. 
Add the Value to the 
crystal.txt file.

Adjust Spectrometer 
Horizontal Axis Position 
for MAXIMUM 
Countrate.

Obtain an Element 
Scan at C Ka Using 
Existing Calibration 
Points.

Adjust Horizontal Axis 
Position - (TWEEK 
ONLY SHOULD NOT 
REQUIRE GROSS 
MOVEMENT).

Specifications 
for CPS/nA and 
FWHM OK?

NO

Loop Limit Should 
Meet Specs With 2-3 
Iterations. If not - See 
Troublshooting.

Troubleshooting

Move to Aluminum 
Specimen (or Highest 
Energy Line Available 
for SEM Energy). 
FOCUS USING WD 
MICROMETER ONLY.

Obtain an Element 
Scan at AlKa Using 
Existing Calibration 
Points.

Position Spectrometer 
at Peak Centroid 
Energy (Send 
Command: “energy 
equals X.XXX”)

Position Spectrometer on 
Lower Energy Peak of 
Convolved Gaussians. Be 
Sure That K α Is Not 
Further Down In Energy 
(i.e. Do Wide Energy 
Scan).

Adjust Tilt Axis Position 
- (TWEEK ONLY - 
SHOULD NOT 
REQUIRE GROSS 
MOVEMENT).

Adjust Intersection 
Position From 
Design Setting. +/- 
3mm Maximum 
Unless Design Error.

Obtain an Element 
Scan at AlKa Using 
Existing Calibration 
Points.

Specifications 
for CPS/nA 
and FWHM 
OK?

YES

NO Peak Shapes 
OK Intensity 

NO

YES

Proceed to 
CALIBRATION

Troubleshooting

Loop Limit Should 
Meet Specs With 2-3 
Iterations. If not - See 
Troublshooting.

YES

Load Standard 
Specimen. Use 
typical sample holder 
for Customer.
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Engineering Layout
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8 – Additional MAXray Drawings
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MAXray Wiring and Plumbing
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Flow Counter Repair/Replacement Instructions
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PCS Electronics Integration on MAXray Spectrometer
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Motor Replacement and Installation
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Diffractor Replacement Instructions
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9 – MAXray Field Replaceable Parts
The table below describes the field re-placable parts for the MAXray spectrometer. 
Failures of the spectrometer which involve other components will probably require 
factory repair.

Supporting documents are provided in the Installation and Alignment Procedures 
documentation, and should be referenced prior to installation of any replacement parts.

Part Description NORAN P/N Supporting Documents

Flow Counter Window 555A135717 930A135978

Flow Counter Window Support 555A135716 930A135987

PCS Electronics 700X135656 930A135984

X-ray OPTIC 555A135665 930A135985

Detector Motor 700P135600 930A135988

Theta Motor 700P135595 930A135988

Turret Motor 350A132828 930A135988

Optical Sensor - All Locations 370A133449 930A135673

Microswitch Limit Switch 510A133869 930A135673

TAP Diffractor 555A135685 930A135989

WSi-50 Diffractor 555A135686 930A135989

WSi-60 Diffractor 555A135687 930A135989

WSi-80 Diffractor 555A135688 930A135989

NiC-80 Diffractor 555A135689 930A135989

CrSc-80 Diffractor 555A135690 930A135989

NiC-100 Diffractor 555A135691 930A135989

MoB4C-145 Diffractor 555A135692 930A135989
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10 – Cleaning Procedures for Synthetic and 
Natural Crystal Diffractors

Cleaning procedure must be preformed by a Service Representative. When crystals are 
placed in a vacuum environment produced by mechanical pumps, diffusion pumps, or a 
combination of the two, oil back-streaming can occur which will contaminate the surface 
of the diffracting elements in a WDS spectrometer. In some instances the oil films can 
become thick enough to lower the detected count rates due to absorption. The same is 
true for the x-ray detector windows. Crystals can be cleaned with care. Flow counter 
windows need to be replaced. The following is the recommended procedure for cleaning 
of various diffractors.

Synthetic Multilayer
Synthetic Multilayer diffractors can be cleaned by rinsing with isopropyl alcohol and 
gently blow drying with nitrogen. DO NOT wipe the surface of the diffractor as this can 
scratch the surface.

TAP
The TAP crystal is the most affected by oil contamination. TAP is a water soluble crystal. 
Remove any oil contamination using a cotton ball wetted with acetone. It is necessary to 
etch the crystal after cleaning due to the destruction of the surface layers during 
cleaning. Dip the crystal into room temperature distilled water for 10 seconds and 
remove. Gently wipe and water droplets from the surface with a dry cotton ball. DO NOT 
use air or nitrogen. A gas stream can cause the crystal to crack due to thermal effects.

PET
The PET crystal is cleaned similarly to the TAP crystal. Although PET isn't as sensitive 
to thermal stresses, use the same precautions during drying.

LiF
The LiF crystal will normally not show any loss of intensity due to oil contamination 
because the x-rays diffracted by LiF are not easily absorbed. The crystal can be cleaned 
with a cotton ball wetted with acetone. No etching is necessary or possible except at the 
factory.
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